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RESUMO 

Os implantes curtos têm mostrado taxas de sucesso semelhantes às dos implantes de tamanho 

convencional, sendo que a estabilidade inicial e a qualidade óssea do leito receptor do 

implante podem influenciar seu prognóstico. Desta forma este estudo teve como objetivo 

avaliar três métodos de aferição da estabilidade dos implantes - torque de inserção (IT), 

periotest (PTV) e Osstell (ISQ) - e o efeito da qualidade óssea avaliada no ato da cirurgia 

(Leckholm e Zarb, 1985) e em imagens de tomografias computadorizadas multislice (CT) ou 

de tomografias computadorizadas cone beam (CBCT), avaliadas visualmente e por densidade 

óptica (variação de tons de cinza em 8bits), na estabilidade primária de 45 implantes curtos 

(Straumann SLActive RN SP 4.1 x 6mm), colocados em 20 pacientes de clínica privada. Para 

todos os implantes estavam previstas coroas metalocerâmicas aparafusadas unitárias. Um 

implante que apresentou ampla mobilidade no momento da colocação não foi implantado e 

não entrou na análise estatística. O nível de significância foi de 5%. Foi encontrada correlação 

(Spearman) entre IT x PTV (-0,686), IT x ISQ (0,606) e PTV x ISQ (-0,627). Foi encontrada 

correlação entre a qualidade óssea cirúrgica e a qualidade óssea visual, contudo não houve 

correlação entre a qualidade óssea cirúrgica e a densidade óptica nem entre a qualidade óssea 

visual e densidade óptica. A estabilidade primária em osso tipo 4 (avaliado cirurgicamente) 

foi estatisticamente menor quando avaliada por PTV, onde a mediana foi -5,0 (-6,0 ; -2,5) no 

tipo 1-2, -3,0 (-3,5 ; 1,5) no tipo 3 e 2,5 (0,8 ; 5,3) no tipo 4 (p <  0,001); ISQ onde a média 

foi de 71,06 (+/- 8,48) no tipo 1-2, 70,24  (+/- 4,24) no tipo 3 e 65,19 (+/- 8,38) no tipo 4 (p < 

0,001); e IT, onde 78,6% dos implantes colocados osso tipo 4 tiveram IT < 15Ncm. Todos os 

implantes obtiveram cicatrização óssea após 3 meses. Desta forma, estes resultados sugerem 

uma correlação moderada entre os métodos de estabilidade primária (IT, PTV e ISQ) e que os 

implantes colocados em osso tipo 4 obtêm menor estabilidade inicial que nos outros tipos 

ósseos. Mais estudos são necessários para validar métodos de avaliação óssea para serem 

utilizados em CT e CBCT. 

 

Palavras-chave: implantes curtos unitários; estabilidade primária; qualidade óssea, torque de 

inserção, Periotest, Osstell. 



 

ABSTRACT 

Short implants have shown success rates similar to implants of conventional length, and both 

bone quality and initial stability of the receptor site of the implant may influence prognosis. 

Therefore, this study aimed to evaluate three methods of measuring implant stability - 

insertion torque (IT), Periotest (PTV) and Osstell (ISQ) - and the effect of bone quality 

evaluated during surgery (Leckholm and Zarb, 1985) and at images of multislice computed 

tomography (CT) or cone beam computed tomography (CBCT), assessed visually and by 

optical density (8bit grayscale), the primary stability of 45 short implants (Straumann 

SLActive® RN SP 4.1 x 6-mm long) placed in 20 patients at a private practice. All implants 

had screw-retained metaloceramic single crowns planned. One implant that showed ample 

mobility at the time of placement was not deployed and thus not entered into the statistical 

analysis. The significance level was set at 5%. Correlation was found (Spearman) between IT 

PTV x (-0.686), IT ISQ x (0.606) x ISQ and PTV (-0.627). Correlation was found between 

surgical bone quality and visual evaluation of CT / CBCT, but there was no correlation 

between surgical bone quality and optical density neither between visual evaluation of CT / 

CBCT and optical density. Primary stability of bone type 4 (evaluated surgically) was 

statistically lower when assessed by PTV, where the median for bones types 1-2, type 3 and 

type 4 were -5.0 (-6.0, -2.5), -3.0 (- 3.5, 1.5) and 2.5 (0.8, 5.3), respectively (p <0.001); ISQ 

average was 71.06 (+ / - 8.48) the type 1-2, 70.24 (+ / - 4.24) and 65.19 in type 3 (+ / - 8.38) 

in the type 4 (p <0.001) and IT, where 78.6% of type 4 bone implants placed had IT <15Ncm. 

Each implant obtained bone healing after 3 months. Thus, these results suggest that a 

moderate correlation between the measurements methods of primary stability (IT, PTV and 

ISQ) can be established and that the implants placed in type 4 bone get smaller initial 

stability than the other bone types. More studies are needed to validate methods for assessing 

bone for use in CT and CBCT. 

 

Key-words: single short implants; primary stability; bone quality, insertion torque, Periotest, 

Osstell. 
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1 INTRODUÇÃO E REVISÃO DE LITERATURA 

Este trabalho, realizado em forma de Tese apresentada como requisito para 

obtenção do grau de Doutor pelo Programa de Pós-Graduação em Odontologia da Faculdade 

de Odontologia da Pontifícia Universidade Católica do Rio Grande do Sul, foi idealizado a 

partir da dúvida clínica sobre a indicação de implantes curtos unitários em região posterior da 

maxila ou da mandíbula e a possibilidade de utilizar meios de diagnóstico de imagem e de 

aferição da estabilidade inicial dos implantes colocados para um correto prognóstico e 

planejamento dos casos de reposição de dentes perdidos com a utilização de implantes curtos 

em regiões posteriores. 

Neste sentido, a possibilidade de prevermos o grau da estabilidade inicial de um 

implante a partir de exames de imagem poderia trazer para o clínico mais segurança na 

indicação desta alternativa de tratamento aos pacientes. Isto se justifica pois uma boa 

estabilidade primária evita que ocorram micromovimentações do implante durante a fase de 

cicatrização, favorecendo uma estabilidade secundária maior e, consequentemente, a própria 

osseointegração (Atsumi et al., 2007). 

Não obstante, esta pesquisa na qual se baseia esta Tese, também faz parte de um 

projeto mais amplo onde se pretende acompanhar por um período longo os indivíduos que 

dela participaram para melhor entender o funcionamento dos implantes curtos unitários em 

região posterior através de um estudo de coorte. 

Para entender o tema, faz-se necessário abordar alguns assuntos pertinentes a 

seguir. 

1.1 Implantes curtos 

 O conceito de implante curto não é consenso na literatura, pois a medida na qual 

incluiu-se os implantes como sendo curtos varia de acordo com o conceito de cada autor, 

sendo que esta medida da altura do implante tem variado em igual e/ou abaixo de 11mm, 

10mm, 9mm, 8mm e 7mm (Bahat, 1993; Brocard et al., 2000; Feldman et al., 2004; Arlin, 

2006; Strietzel e Reichart, 2007; Cannizzaro et al., 2008; Deporter et al., 2008; Corrente et al., 

2009; De Santis et al., 2011). 

 Tradicionalmente, a indicação de implantes curtos tem sido encarada com 

ressalvas por muitos clínicos devido à associação desta opção de tratamento a maiores índices 

de perdas e complicações, principalmente devido às suas características biomecânicas 

inferiores, em comparação aos implantes longos (Van Steenberghe et al., 1990; Bahat, 1993; 
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Higushi et al., 1995; Grunder et al., 1999; Block et al., 1996; Baelum e Ellengaard, 2004), 

mesmo que estudos longitudinais de um a três anos tenham mostrado índices de sucesso dos 

implantes curtos acima de 95% (Tawil e Younan, 2003; Grant et al., 2007; Rossi et al., 2010; 

Esposito et al., 2011 (a); Maló et al., 2011; De Santis et al., 2011) assim como outros estudos 

clínicos longitudinais, com mais de sete anos de acompanhamento, tenham mostrado índices 

acima de 90% de sobrevivência de implantes curtos (Buser et al., 1997; Brocard et al., 2000; 

Nedir et al., 2004; Blanes et al., 2007; Deporter et al., 2008). 

 Por sua vez, pesquisas com elementos finitos mostram que o aumento do diâmetro 

e da altura do implante diminui as tensões na crista óssea ao redor dos implantes e que a 

interação de implantes curtos, estreitos e cônicos aumenta a tensão no osso de 1,65 vezes 

(Petrie e Williams, 2005). Outro estudo (Himmlová et al., 2004) mostra que esta tensão se 

concentra no pescoço do implante e na crista óssea, sendo que o aumento do diâmetro do 

implante diminui as tensões do sistema, assim como o aumento da altura só que com menos 

efeito. Em sentido oposto, outro estudo de elementos finitos indica que o estresse máximo no 

osso é praticamente independente do comprimento do implante e a concentração do estresse 

ocorre na região do osso cortical próximo da cabeça do implante (Pierrisnard et al., 2003). 

Além disso, estudo de elementos finitos como o de Bergkvist e colaboradores (2008) mostram 

maiores tensões sobre o tecido ósseo em implantes unitários do que em implantes ferulizados.  

 Por outro lado, devido à evolução do tratamento de superfície dos implantes – 

como os implantes com superfície hidrofílica (SLActive®, Straumann Dental Implant 

System, Waldenburg, Suíça) (Buser et al., 2004; Bornstein et al., 2008; Ganeles et al., 2008) - 

o uso dos implantes curtos tem aumentado uma vez que os índices de sucesso destes 

implantes com tratamento de superfície se mostraram melhores que os implantes curtos lisos e 

semelhantes aos implantes longos (Van Steenberghe et al., 1990; Higushi et al., 1995; 

Grunder et al., 1999; Davarpanah et al., 2001; Feldman et al., 2004; Blanes et al., 2007; Rossi 

et al., 2010; De Santis et al., 2011). 

 Da mesma forma, em ensaios clínicos controlados randomizados, os implantes 

curtos mostraram resultados semelhantes aos implantes mais longos associados à enxerto 

ósseo (Esposito et al., 2011 (a); Esposito et al., 2011 (b); Perelli et al., 2011; Esposito et al., 

2012; Pieri et al., 2012).  

 As vantagens clínicas da indicação dos implantes curtos são: 

 - Menor morbidade para o paciente (Renouard e Nisand, 2006; Grant et al., 2009), 

visto que não seriam necessários outros procedimentos cirúrgicos prévios à colocação do 

implante como regeneração óssea guiada (Buser et al., 1990, Buser et al., 1993), distração 
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osteogênica (Ilizarov, 1989), aumento do assoalho do seio maxilar (Summers, 1995), enxertos 

ósseos (Bell et al., 2002) e lateralização do nervo alveolar inferior (Rosenquist, 1992); 

 - Maior facilidade cirúrgica em espaço interoclusal reduzido (Grant et al., 2009); 

 - Menor aquecimento do osso durante a fresagem cirúrgica para colocação do 

implante (Grant et al., 2009); 

 - Menor risco de lesão na raiz adjacente (Grant et al., 2009); e 

 - Menor tempo e custo de tratamento por evitar cirurgias extras e/ou mais 

complexas (Renouard e Nisand, 2006; Grant et al., 2009). 

 Não obstante, um dos fatores mais importantes para o sucesso do uso dos 

implantes curtos é a estabilidade primária alcançada na cirurgia de colocação do implante, 

visto que uma possível micromovimentação do implante pode gerar a formação de uma 

cápsula fibrosa circundando o implante levando à sua perda (Lioubavina-Hack et al., 2006; 

Alsaadi et al., 2007; Alsaadi et al., 2008). Portanto, a estabilidade secundária, e 

conseqüentemente a osseointegração, está diretamente relacionada com a estabilidade 

primária (Atsumi et al., 2007; Karl et al., 2008). 

1.2 Estabilidade primária e os métodos para medição  

 A estabilidade de um implante pode ser definida como a ausência de mobilidade 

clínica sob uma carga específica, que depende do contato da superfície do implante e o tecido 

ósseo adjacente, sendo que a estabilidade primária é aquela alcançada no termino da 

colocação do implante (Herrero-Climent et al., 2012). 

 Entre os métodos de medição de estabilidade dos implantes e sua relação de 

contato com o tecido ósseo descritos na literatura estão: análise histológica ou 

histomorfométrica através de biópsia; teste de percussão sonora; exames de imagem; 

percepção subjetiva do cirurgião; torque reverso; torque de corte ou resistência ao corte; 

torque de inserção; análise de vibração, também chamada de análise de frequência de 

ressonância (RFA, sigla em inglês de Resonance Frequency Analyses) – Osstell; análise da 

capacidade de amortecimento - Periotest; e análise modal teórica - análise de elementos 

finitos (Atsumi et al., 2007; Cehreli et al., 2009, Degidi et al., 2010). Destes métodos, os que 

possuem aplicabilidade clínica são os exames de imagem (por avaliação indireta do implante 

em relação ao osso); torque de inserção (avaliação da estabilidade primária); análise de 

vibração e análise da capacidade de amortecimento (ambos para avaliação da estabilidade 

primária e secundária). Estes três últimos métodos representam uma avaliação objetiva da 
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estabilidade dos implantes (Zix et al., 2008; Cooper, 2010; Degidi et al., 2010; Oh e Kim, 

2012). 

1.2.1 Toque de Inserção 

O torque de inserção (IT, insertion torque, em inglês) é medido apenas no 

momento da colocação do implante através de aparelhos elétricos ou manuais e reflete a 

quantidade de força por área que foi alcançada no travamento do implante no sítio ósseo, 

geralmente é expresso em Newton por centímetro (Ncm) e estaria relacionado ao íntimo 

contato entre o implante e o osso e as características de ambos (Walker et al., 2011). Ou seja, 

o torque de inserção é uma função do estresse de compressão aplicado localmente no osso 

circundante e o atrito na interface osso-implante (Molly, 2006). 

 As características do implante que podem influenciar o torque de inserção são a 

forma, as dimensões de altura e diâmetro, desenho das roscas e características de superfície 

dos implantes. Já as características do osso são o tipo ósseo, espessura da cortical, estrutura do 

osso medular, grau de mineralização, e sua densidade (Akça et al., 2006; Alsaadi et al., 2007; 

Degidi et al., 2010; Walker et al., 2011). 

 Quanto maior é o torque de inserção maior é a resistência do conjunto osso e 

implante às forças de cisalhamento a que for submetido o conjunto. Estas tendem a girar o 

implante no seu sítio dentro do osso, portanto a resistência deste conjunto ao movimento 

referido é importante durante o período de osseointegração (Degidi et al., 2010). 

 A avaliação do torque de inserção é um dos métodos mais utilizados para 

verificação da estabilidade primária por ser prático e fácil de obtê-lo no momento da 

instalação do implante, contudo não se conhece um valor ou parâmetro para determinação de 

um prognóstico favorável à osseointegração de um implante. Apesar disso, implantes com 

baixo torque de inserção estão mais relacionados com falhas de osseointegração, da mesma 

forma que os implantes com torque de inserção mais altos estão relacionados com sucesso na 

osseointegração e na alteração de protocolos de carga dos implantes - carga imediata e carga 

precoce (Trisi e Rao, 1999; Barewal et al., 2003; Ottoni et al., 2005; Zix et al., 2005; Al-

Nawas et al., 2006; Rabel et al., 2007; Trisi et al., 2009; Walker et al., 2011). 

 Walker e colaboradores (2011) classificaram os valores do torque de inserção em 

três grupos: torque de inserção baixo eram aqueles cujos valores eram menores que 15 Ncm; 

torque de inserção médio aqueles cujos valores estavam entre o travamento com 15 Ncm e 

valores menores que 30 Ncm; e torque de inserção alto eram aqueles com valores com 
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travamento em 30 Ncm ou valores acima de 30 Ncm. Já Degidi e seus colaboradores (2010) 

estabeleceram como torque de inserção baixo aqueles com medição de 0 a 25Ncm; torque de 

inserção médio aqueles com medição de 26 a 50 Ncm; e torque de inserção alto aqueles com 

medição acima de 51 Ncm.  

1.2.2 Análise da capacidade de amortecimento - Periotest  

 O Periotest® (Gulden-Medizintechnik, Bensheiman der Bergstrabe, Alemanha) foi 

desenvolvido inicialmente para medir a mobilidade dos dentes através da análise da 

capacidade de amortecimento (Schulte e Lukas, 1993). Contudo, este aparelho tem sido 

utilizado para avaliar a estabilidade primária e ou secundária de implantes dentários (Olivé e 

Aparício, 1990; Deporter et al., 2002; Lachmann et al., 2006 (a); Lachmann et al., 2006 (b); 

Noguerol et al., 2006; Alsaadi et al., 2007; Zix et al., 2008; Cehreli et a.l, 2009; Oh et al., 

2009; Merheb et al., 2010 (a); Merheb et al., 2010 (b); Oh e Kim, 2012). Ele consiste em um 

aparelho que mede a capacidade de amortecimento do implante através da desaceleração que 

o bastão (pistilo ou martelete) do dispositivo de medição sofre ao bater contra o implante, 

componente protético ou coroa fixada no implante. Esta desaceleração é convertida em Valor 

de Periotest (PTV), que varia de -8 a 50 (Olivé e Aparício, 1990).  

 Este aparelho baseia-se no método do impacto por martelete, onde a força do 

impacto é usada como força de excitação. Portanto, na presença da força do impacto, menor 

rigidez do objeto testado resulta em um eixo de tempo mais longo. É utilizado um batente 

metálico em uma peça de mão eletromagneticamente impulsionado e controlado 

eletronicamente para estimular o objeto em teste. A cabeça deste batente atinge o objeto 

testado quatro vezes por segundo. A resposta à batida é medida por um pequeno acelerômetro 

acoplado na cabeça do dispositivo. O tempo do contato do objeto testado com o batente é 

medido no eixo do tempo como um sinal para análise. Os sinais são convertidos depois em 

um único valor chamado valor de periotest (PTV, periotest value, em inglês), o qual depende 

das características de amortecimento dos tecidos circundando o implante ou o dente em teste 

(Atsumi et al., 2007). 

 Acredita-se que a característica do contato osso e implante, por não ter a presença 

do ligamento periodontal, é similar ao modelo de mola em série que segue a lei de Hooke, e a 

medida da mobilidade no implante é considerada mais fácil do que no dente (Atsumi et al., 

2007). 
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 Apesar de ser fácil e prática a utilização do Periotest, visto que consistem em um 

leitor digital do valor de periotest com bateria e a peça de mão com o batente e o acelerômetro 

na cabeça do batente, a técnica de manipulação para a medição é sensível ao operador. Isto 

porque a medição da estabilidade do implante ou do dente deve ser realizada com a sonda, ou 

peça de mão, nivelada em um ângulo reto com o objeto a ser testado, e seu contato com o 

mesmo deve ser o mais perto da crista óssea possível (Cranin et al., 1998; Aparicio et al., 

2006; Atsumi et al., 2007). 

 Segundo o próprio fabricante do Periotest, o PTV pode ser escalonado em -8 a 0 

como sendo boa estabilidade ou implante osseointegrado; 1 a 9 implante com estabilidade que 

não deve receber carga; e 10 a 50 como estabilidade insuficiente ou perda da osseointegração 

(Periotest Procedure). Contudo, Olivé e Aparicio (1990) indicam que implantes 

osteointegrados variam em PTV de -5 a 5. Por sua vez, Noguerol e colaboradores (2006) 

verificaram que implantes com estabilidade inicial acima de -2 PTV possuíam risco 

aumentado para falha inicial, sendo que este ponto de corte possuía sensibilidade de 84% e 

especificidade de 39%. 

1.2.3 Análise de frequência de ressonância – Osstell 

 O Osstell é outro aparelho que mede a rigidez do conjunto osso e implante e a sua 

capacidade de resistir às forças de flexão através da análise de frequência de ressonância 

(RFA), analisando a frequência da oscilação do implante dentro do osso (Degidi et al., 2010). 

Quanto mais rígido for o conjunto osso e implante, maior será a frequência de oscilação do 

transdutor. Este aparelho pode ser utilizado tanto para verificar a estabilidade primária quanto 

a estabilidade secundária ao longo do tempo (Herrero-Climent et al., 2012).  

 Este aparelho possui 4 gerações, sendo que as duas últimas utilizam um sistema 

sem fios para a análise da frequência de ressonância (num intervalo de 1.100 a 10.000Hz) 

onde um transdutor em forma de munhão, ou peg (Smartpeg®, Integration Diagnostics AB, 

Suécia), é fixado ao implante ou ao pilar com o auxílio de um montador específico, sendo que 

4 a 5Ncm de torque é suficiente para tanto. Cada tipo de implante ou pilar possui um 

SmartPeg específico (Alsaadi et al., 2007). O SmartPeg, que possui um imã interno, é 

excitado por ondas eletromagnéticas quando da aproximação de uma sonda que excita este 

conjunto sem tocá-lo e registra a quantidade de vibração. Esta vibração é transformada pelo 

aparelho de hertz (Hz) em uma unidade de medida chamada de quociente de estabilidade do 

implante (ISQ, em inglês Implant Stability Quotient), e varia de 1 a 100 (Lachmann et al., 



23 

 

2006 (a); Lachmann et al., 2006 (b); Sennerby e Meredith, 2008). Esta transformação dos 

dados na escala de ISQ foi idealizada para facilitar a compreensão do resultado da medição 

por parte do observador (Meredith, 1994; Meredith et al., 1996; Meredith et al., 1998). 

 Ainda não há parâmetros definidos para estabelecer quando um implante está 

estável e quando está em risco a partir da análise do ISQ. Contudo, há indícios que baixos 

valores de ISQ estão ligados com perda da estabilidade dos implantes e sua falência (Aparício 

et al., 2006). Por exemplo, em um estudo realizado por Rodrigo e colaboradores (2010), 

nenhum dos implantes com estabilidade primária acima de 60 ISQ foi perdido, enquanto que 

19% dos implantes com estabilidade inicial menor que 60 ISQ foram perdidos. Desta maneira, 

o Osstell tem sido bastante utilizado para avaliação da estabilidade dos implantes (Meredith, 

1994; Meredith et al., 1996; Sennerby e Meredith, 2008; Bornstein et al., 2009; Oh et al., 

2009; Chan et al. 2010; Han et al., 2010; Merheb et al., 2010 (b); Rodrigo et al., 2010; Rossi 

et al., 2010; Sim e Lang, 2010; Hsu et al., 2012; Oh e Kim, 2012). 

 Apesar destes três métodos objetivos e não-invasivos de medição da estabilidade 

dos implantes possuírem limitações inerentes à cada técnica, há outros fatores que podem 

influenciar a estabilidade primária e sua aferição objetiva, onde está incluída a qualidade e 

quantidade óssea; a região na arcada dentária; a técnica cirúrgica; a habilidade do cirurgião; e 

as características do implante como a sua geometria, comprimento, largura e tratamento de 

superfície (Aparicio et al., 2006; Atsumi et al., 2007; Hong et al., 2011).  

 Destes fatores, alguns podem ser controlados ou aprimorados pelo cirurgião-

dentista para alcançar a melhor estabilidade primária possível, como é o caso das 

características do implante, a técnica cirúrgica, a habilidade e o treinamento do profissional. 

Contudo, a qualidade óssea varia intra e inter-paciente, uma vez que esta característica 

depende da espessura da cortical óssea, da abundância do osso trabecular e da quantidade de 

mineralização do tecido ósseo na área de interesse para a colocação de implante 

(Valiyaparambil et al., 2012). Ainda, os estudos tem mostrado associação positiva entre a 

densidade óssea e a estabilidade primária (Marquezan et al., 2012), o volume ósseo e a 

estabilidade primária dos implantes (Makari et al., 2011) e a espessura da cortical óssea e a 

estabilidade primária (Merheb et al., 2010 (b)). Desta forma, saber qual é e como classificar a 

qualidade óssea de uma área onde será colocado um implante é importante para o 

planejamento e condução da reabilitação, principalmente com implantes curtos. 
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1.3 Avaliação da qualidade óssea  

 Qualidade óssea é um termo genericamente usado, na odontologia e 

principalmente na implantodontia,  para avaliação do tecido ósseo da maxila e da mandíbula 

que envolve três níveis: a qualidade estrutural do osso, no que se refere à quantidade de osso 

cortical e o padrão do osso trabecular; a densidade óssea, no que diz respeito à quantidade de 

mineralização do osso e/ou a quantidade de osso por seu volume; e quantidade óssea, no que 

diz respeito ao volume do osso disponível (Ribeiro-Rotta et al., 2007; Ribeiro-Rotta et al., 

2010). 

 Para avaliação da qualidade óssea o padrão ouro é a biópsia da região, contudo, 

não se mostra um método viável para utilização rotineira, sendo mais utilizado em pesquisas 

pré-clínicas (Aparicio et al., 2006). Portanto, os métodos mais utilizados são as avaliações 

pré-cirúrgicas através de recursos radiográficos ou tomográficos e no ato cirúrgico através da 

avaliação subjetiva do cirurgião (Lekholm e Zarb, 1985; Misch, 1990; Lindh et al., 1996; 

Trisi e Rao, 1999; Ribeiro-Rotta et al., 2007; Trisi et al., 2009; Ribeiro-Rotta et al., 2010; 

Fuster-Torres et al., 2011; Arsian et al., 2012; Valiyaparambil et al., 2012). 

 Os termos densidade óssea, quantidade de osso, e qualidade do osso são 

complexos e aberto à interpretação considerável na literatura, demonstrando falta de consenso 

e padronização para avaliação das características do tecido ósseo onde será ou é colocado um 

implante. Diferentes classificações para descrever estas características do tecido ósseo, têm 

sido propostas. A classificação mais amplamente aceita de quantidade óssea e qualidade óssea 

no tratamento de implante dentário foi estabelecida por Lekholm e Zarb (1985) idealizada 

com base em radiografias pré-operatórias e de perfuração exploratória em preparação do local 

do implante considerando-se que o tecido do osso trabecular varia na estrutura e que a camada 

compacta osso trabecular circundante varia em espessura (Ribeiro-Rotta et al., 2010). 

 Segundo Lekholm e Zarb (1985), o tecido ósseo era avaliado radiograficamente e 

cirurgicamente (através da percepção tátil e experiência do cirurgião) quanto as características 

estruturais e o volume ósseo disponível. A avaliação da qualidade óssea baseada em seu 

arranjo estrutural era classificada como osso tipo 1 quando havia cortical óssea envolvendo 

praticamente toda a área óssea e pouco osso trabecular; osso tipo 2 quando havia cortical 

óssea espessa e trabeculado ósseo denso; osso tipo 3 quando havia cortical óssea fina e 

trabeculado ósseo denso; e osso tipo 4 quando havia cortical óssea fina e trabeculado ósseo 

rarefeito. Com relação à quantidade óssea disponível, o osso era classificado como A quando 

havia a maior parte do osso alveolar presente; B quando havia reabsorção óssea moderada do 
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rebordo residual; C quando havia reabsorção avançada do rebordo residual e restava apenas 

osso basal; D quando havia reabsorção inicial do osso basal; e E quando havia reabsorção 

extrema do osso basal. 

 Apesar de ser a mais difundida e utilizada, a classificação de Lekholm e Zarb 

(1985) ainda nao foi validada em nenhum estudo (Ribeiro-Rotta et al., 2010). 

 Misch (1990) introduziu uma classificação de densidade óssea com base na 

sensação tátil durante a perfuração para inserção do implante e relacionada com a densidade 

medida em imagens de tomografia computadorizada, em Unidades Hounsfield (HU). Esta 

classificação compreendia: D1 sendo um osso cortical denso (> 1250 HU); D2 sendo um osso 

com cortical espesso denso a poroso com osso trabeculado grosso (850 a 1250 HU); D3 sendo 

um osso com cortical fina e com osso trabeculado fino (350 a 850 HU); D4 sendo um osso 

quase totalmente de osso trabeculado fino (150 a 350 HU); e D5 como sendo o osso não 

mineralizado ou imaturo (< 150 HU). 

 Lindh e colaboradores (1996) sugeriram uma nova classificação da qualidade 

óssea através do padrão de osso trabecular avaliado em radiografias. Esta classificação era 

baseada em três níveis: denso onde ocorre apenas trabeculado denso; denso/esparso onde 

ocorre trabeculado variando de denso a esparso; e esparso onde ocorre apenas trabeculado 

esparso. 

 Trisi e Rao (1999) propuseram a classificação óssea a partir da avaliação da 

densidade óssea percebida pelo cirurgião no momento da fresagem óssea e comparado com a 

biópsia e avaliação histomorfométrica da mesma região, onde a densidade óssea foi dada pela 

porcentagem de osso trabecular em função do seu volume. A classificação era em quatro 

níveis, do mais denso ao menos denso: D1, D2, D3 e D4. Neste estudo, a porcentagem de 

osso trabecular média para cada tipo ósseo foi de 76,54% (+/- 16,19); 66,78% (+/- 15,82); 

59,61% (+/- 19,55); e 28,28% (+/- 12,02), respectivamente. Os cirurgiões conseguiram 

diferenciar estatisticamente as classificações D1 e D4. 

1.4 Avaliação do tecido ósseo através de tomografia computadorizada  

 Na década de 70, os resultados do trabalho de Hounsfield e Cormack 

revolucionaram a imagiologia de diagnóstico com a invenção do scanner de tomografia 

computadorizada (CT). Pela primeira vez, os profissionais da área da saúde tiveram acesso a 

dispositivos de raios-x que poderiam gerar imagens transversais estreitas, geralmente 

perpendicular ao longo eixo do corpo humano, por conseguinte, o termo tomografia axial 
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computadorizada ou CAT scan. Atualmente já estamos na 4a geração de aparelhos de 

tomografia (Angelopoulos et al., 2012). 

 Nestes dispositivos, a aquisição da imagem é realizada em cortes axiais do 

paciente, onde a fonte de raio-x (tubo de raio-x) está fixada aos sensores em forma de arco e 

ficam em torno do paciente. O conjunto se move ao redor do paciente e a cada 360o ocorre o 

movimento de translação do paciente o que gera uma trajetória helicoidal ou espiral. A 

reconstrução dos dados de atenuação de raios-x transmitido por algoritmos de software 

específicos produz fatias de imagem adjacentes de volumes formando as imagens do paciente 

(Angelopoulos et al., 2012). 

 Mais recentemente, foi desenvolvido outro método de imageologia, a tomografia 

computadorizada cone beam (CBCT). A sua aquisição de imagem é realizada utilizando uma 

plataforma rotativa na qual uma fonte de raios-x e o sensor são fixos. Uma fonte piramidal ou 

em forma de cone divergente de radiação ionizante (semelhante em forma ao feixe divergente 

de imagiologia transmissão tradicional 2D) é direcionada e transmitida através da região de 

interesse (ROI), radiação atenuada é projetada para uma área do detector de raios-x no lado 

oposto. Ao contrário da tomografia computadorizada (CT), o paciente não se move. O fulcro 

do movimento de rotação é o centro do volume adquirido. Durante a rotação, várias imagens 

de projeção planar sequênciais abrangidos pelo detector ou o campo de visão (FOV) são 

adquiridos em um arco maior ou igual a 180o. Apenas uma sequência de rotação é necessária 

para adquirir dados suficientes para a construção da imagem volumétrica porque o FOV é 

irradiado simultaneamente (Angelopoulos et al., 2012). 

 Consequentemente, tanto a tomografia computadorizada (CT) quanto a 

tomografia computadorizada cone beam (CBCT) têm sido os exames rotineiramente 

utilizados para a avaliação óssea pré-cirúrgica para colocação de implantes, devido às suas 

características de avaliação da quantidade óssea, da qualidade óssea relativa, avaliação em 

três dimensões (3D) da topografia do rebordo alveolar e a relação com as estruturas 

anatômicas como o seio maxilar e o canal alveolar inferior (Benavides et al., 2012). Porém, o 

uso da CBCT tem aumentado em relação ao uso da CT, já que a CBCT tem algumas 

vantagens quando comparado com CT, como o aumento do conforto do paciente, doses 

menores de radiação e os custos de operação (Scarfe et al., 2006). 

 Por outro lado, nas tomografias computadorizadas (CT), a utilização das Unidades 

Hounsfield (HU) para avaliação da densidade óssea de uma região de interesse na imagem 

tomográfica é uma metodologia validada e amplamente utilizada (Turkyilmaz, et al., 2007; 

Turkyilmaz et al., 2008 (a); Fuh et al., 2010; Arisan et al., 2012; Valiyaparambil et al., 2012). 
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Esta metodologia se baseia no princípio de atenuação dos raios-x ao atravessarem objetos, 

onde esta atenuação é mais intensa quanto maior é o número atômico dos elementos 

constituintes do objeto exposto, como o cálcio nos ossos, e também de acordo com a 

espessura deste objeto, formando imagens mais próximas do branco, ou hiperdensa. Como 

referência de calibração é usado o coeficiente da água, sendo a ele atribuído o valor zero na 

escala de Hounsfield (Quadro 1). Através de um cálculo matemático, as HU traduzem em 

números a variação de tons de cinza da imagem do objeto formada em função da atenuação 

dos raios-x ao atravessarem o objeto exposto (Oliveira et al., 2008; Turkyilmaz et al., 2008 

(b); Fuh et al., 2010; Arisan et al., 2012; Isoda et al., 2012; Valiyaparambil et al., 2012). 

 

Quadro 1: Exemplos de valores de Unidades Hounsfield de acordo com o objeto exposto 

aos raios-x (White e Pharoah, 2004). 

Ar Água Osso Cortical 

-1000 HU 0 HU > 1000 

 

 Com relação à avaliação da qualidade óssea através da CBCT, vários autores têm 

relatado o uso de valores de intensidade como medida de referência para a avaliação da 

densidade óssea com imagens de CBCT (Lee et al., 2007; Katsumata et al., 2009), em 

analogia com a HU obtida com CT (Katsumata et al., 2007; Mah et al., 2010). Contudo, os 

dados da CBCT têm uma quantidade maior de raios-X dispersos do que a CT. Isto pode 

aumentar o ruído em imagens reconstruídas, e, portanto, afetar a detecção de baixo contraste. 

Por causa da dispersão e artefatos, os valores de HU em CBCT não são válidos e, portanto, o 

método de correlacionar densidade óssea mineral aos valores HU de CBCT não é ideal. Além 

disso, a dispersão e artefatos, na CBCT, pioram em torno dos tecidos não homogêneos com 

valores HU reduzidos até 200 HU. O endurecimento do feixe é um fenômeno resultante do 

aumento da energia média do feixe de raios-X, quando ele passa através de um objeto, 

causando artefatos na reconstrução da imagem. Devido ao endurecimento do feixe, o valor de 

HU de certas estruturas, tais como o tecido mole e osso alteram-se. O sensor único da CBCT 

tem uma largura de feixe maior do que a linha de multi-sensores da CT. Isto provoca uma 

distribuição angular não-uniforme da intensidade do feixe de raios X conhecido como o efeito 

de salto, o que também faz as HU não terem qualquer uniformidade na CBCT (Hua et al., 

2009; Nackaerts et al., 2011). 

 Apesar disso, alguns estudos que fizeram a avaliação de densidade óssea através 

de CBCT têm utilizado as HU como medida para avaliação da qualidade do tecido ósseo 
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através deste tipo de exame tomográfico (Fuster-Torres et al., 2011; Isoda et al., 2012; Kaya 

et al., 2012; Pagliani et al., 2013). 

 Com intuito de corrigir esta deficiência na utilização de HU  nas tomografias cone 

beam (CBCT) a variação do grau de tons de cinza da imagem, ou densidade óptica, tem sido 

sugerido como método para medir a qualidade óssea, baseando-se no princípio físico da 

atenuação e absorção dos raios-X ao atravessarem objetos. (Nackaerts et al., 2011; Arisan et 

al., 2012; Pauwels et al., 2013). Após serem atenuados pelo objeto exposto, os raios-x chegam 

ao detector onde o voxel e a sua escala de tom de cinza - ou sua densidade - é formado de 

acordo com a atenuação da sua respectiva região do objeto exposto. O voxel é a menor parte 

de uma imagem digital em volume (eixo x, y e z), sendo que seu correspondente 

bidimensional é o pixel (eixo x e y), o qual compõe as imagens digitais nos cortes 

tomográficos - axial, sagital, coronal ou oblíquo. As imagens digitais são grades 

bidimensionais de valores de intensidade de pixel com a largura e altura da imagem a ser 

definidos pelo número de pixels em direção x (colunas) e y (linhas). Assim, pixels (elementos 

de imagem) são os menores componentes únicos de imagens, mantendo os valores numéricos 

- intensidades de pixel - que variam entre o preto ao branco. As características desta gama, 

isto é, o número único de intensidade (brilho) dos valores que podem existir na imagem é 

definida como a profundidade de bits da imagem e determina o nível de precisão, em que as 

intensidades são codificados, por exemplo: A imagem em 2 bits tem 22 = 4 tons: 00 (preto), 

01 (cinza), 10 (cinza) e 11 (branco). A imagem de 4 bits tem 24 = 16 tons que vão de 0000 (0) 

a 1111 (15), assim por diante. Em termos de bits por pixel (bpp), os tipos mais freqüentes de 

imagens com são: 8 bits - 256 tons de cinza; 16 bits - 65.536 tons de cinza; e 32 bits - 

4.294.967.296 tons de cinza (Ferreira e Rasband, 2011). 

 Segundo Parsa e colaboradores (2013), o tom de cinza de um voxel pode ser 

influenciado pelo tamanho do FOV, pelo número de projeções escolhido e pela seleção da 

resolução espacial. No entanto, os valores de tons de cinza dos voxels na CBCT se afastam 

das HU em CT, quando analisadas as mesmas áreas ósseas. Mesmo assim, há uma forte 

correlação entre a variação dos tons de cinza em CBCT e as HU em CT (Parsa, et al., 2012; 

Reeves et al., 2012; Valiyaparambil et al., 2012; Cassetta et al., 2013; Parsa et al., 2013). 

 Não obstante, outra avaliação da qualidade óssea nas tomografias 

computadorizadas, tanto na CT quanto na CBCT, que pode ser realizada é a análise das 

imagens de tomografia computadorizada a partir da inspeção visual (análise subjetiva) para 

determinar a classificação óssea, como a de Lekholm e Zarb (1985), uma vez que a 

dificuldade da sobreposição de estruturas anatômicas das radiografias panorâmicas não 
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acontece nas tomografias facilitando a visualização da área de interesse (Lekholm e Zarb, 

1985; Oliveira et al., 2008; Rozé et al., 2009; Song et al., 2009). 

 Tanto para análise objetiva (quantitativa em HU ou tons de cinza) quanto para a 

análise subjetiva (visual) das imagens de tomografias, são utilizados programas de 

computador que trabalham a imagem, como, por exemplo, Software Implametric - 3Dent 

(Fuster-Torres et al., 2011), Simplant Software - Columbia Scientific (Norton e Gamble, 

2001), On Demand 3D - CyberMed International, Seoul, Korea (Mah et al., 2010), Osirix 

Imaging Software (Valiyaparambil et al., 2012), eFilm (Oliveira et al., 2008), StentCad 

Software - Media Lab Software, La Spezia, Italy (Turkyilmaz et al., 2008 (a)); DentaCT 

(Oliveira et al., 2008) e ImageJ (Ferreira e Rasband, 2011).  

 Destes, o ImageJ® é um software de domínio público de processamento e análise 

de imagem do programa Java inspirado no NIH image (National Institute of Health ) para o 

Macintosh. Corre, ou como um applet on-line ou como um aplicativo para download, em 

qualquer computador com Java 1.5 ou posterior. Distribuições estão disponíveis para 

download para Windows, Mac OSX e Linux. Desta forma, pode exibir, editar, analisar, 

processar, salvar e imprimir imagens de 8 bits, 16 bits e 32 bits. Também pode ler vários 

formatos de imagem, incluindo TIFF, GIF, JPEG, BMP, DICOM, FITS e "bruto" (Ferreira e 

Rasband, 2011).  

 



30 

 

2 OBJETIVOS  

 Objetivo Geral:  

 

Este estudo tem o objetivo geral de comparar a estabilidade primária de implantes 

curtos em região posterior e a qualidade óssea avaliada tanto clinica quanto 

radiograficamente. 

 

Objetivos Específicos: 

 

Avaliar o efeito da qualidade óssea na estabilidade primária. 

Correlacionar os métodos de medição da estabilidade primária: torque de inserção, 

análise da capacidade de amortecimento e análise de frequência de ressonância. 

Correlacionar os métodos de avaliação da qualidade óssea: avaliação da qualidade 

óssea cirúrgica, avaliação visual da qualidade óssea e densidade óptica. 

 Estabelecer um grupo de coorte para avaliação clínica do prognóstico do 

tratamento com implantes de superfície hidrofílica de plataforma regular e comprimento curto 

(6-mm). 
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3 MATERIAL E MÉTODO  

 

 O delineamento deste estudo caracteriza-se como um estudo transversal e teve 

aprovação na Comissão Científica e de Ética da Faculdade de Odontologia (CCEFO) e no 

Comitê de Ética em Pesquisa (CEP) do Hospital São Lucas, ambos da Pontifícia Universidade 

Católica do Rio Grande do Sul (PUCRS) (Anexo A). A amostra foi constituída por 20 

pacientes atendidos em clínica particular na cidade de Porto Alegre, Rio Grande do Sul, Brasil 

(pelos cirurgiões-dentistas Diego Triches, Fernando Alonso e Luis Mezzomo) que tiveram 45 

implantes colocados. Os critérios de elegibilidade dos sujeitos da amostra foram: 

  Critérios de inclusão: 

 Pacientes adultos com necessidade de implantes para coroas unitárias em 

região posterior de maxila e mandíbula; 

 Pacientes com indicação de implantes de 6mm de comprimento, de acordo 

com a avaliação da tomografia levando-se em consideração 2mm de 

margem de segurança para o canal do nervo alveolar inferior, da fóvea da 

glândula submandibular e do seio maxilar. 

Critérios de exclusão: 

  Problemas anteriores de falha de osseointegração na região de interesse; 

  Problemas psiquiátricos que não permitam o entendimento do tratamento e 

da pesquisa para assinatura do consentimento livre e informado; 

  Áreas de enxerto ósseo ou de uso de biomateriais; 

 Uso de Bisfosfonatos; 

 Diabetes; 

 Tabagismo acima de 10 cigarros por dia (Alsaadi et al., 2008);  

 Imunossupressão; 

 Radioterapia local; 

 Doença periodontal ativa nos dentes remanescentes; 

 Pobre higiene oral; 

 Lesões císticas ou neoplásicas na região de interesse;  

 Portadores de Prótese Parcial Removível ou Prótese Total na arcada 

antagonista. 

 Nas figuras 1 e 2 temos a imagem clínica e tomográfica de um paciente 

selecionado para este estudo de acordo com os critérios de elegibilidade descritos acima. 
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Figura 1: Imagem clínica do local selecionado para colocação do implante, na área do dente 

26.  

 

 

 

Figura 2: Imagem da tomografia computadorizada cone beam evidenciando altura óssea com 

indicação de implante curto (6 mm). 
 

 

 

 A partir da comprovação de indicação de implante curto através da tomografia e 

após a assinatura do consentimento livre e esclarecido (Anexo B), foram instalados implantes 

Standard Plus Regular Neck SLActive (Straumann Dental Implant System, Waldenburg, 

Suíça) de 6 mm de comprimento, seguindo o protocolo de um estágio cirúrgico como 

recomendado pela empresa. A reabilitação protética planejada para estes implantes eram 

coroa metalocerâmicas aparafusadas unitárias. Os dados foram coletados para cada sujeito nos 

seguintes momentos e registrados em um prontuário especificamente formatado para a 

pesquisa: 

  T0 (consulta inicial): anamnese, exame clínico, avaliação periodontal e 

avaliação da Tomografia Computadorizada para planejamento cirúrgico. 
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  T1 (instalação do implante): dados dos implantes (comprimento, diâmetro, 

marca e modelo); Verificação da estabilidade inicial do implante através de 

equipamento de análise de frequência de ressonância (Osstell Mentor®, 

Integration Diagnostics AB, Gotemburgo, Suécia), do aparelho Periotest 

(Medizintechnik Gulden, Eschenweg, Alemanha) e do torque de inserção 

do implante com o uso de uma catraca manual com um torquímetro manual 

acoplado (Straumann Dental Implant System, Waldenburg, Suíça). 

3.1 Anamnese e exame clínico  

 Na anamnese foi utilizado um questionário estruturado padronizado para obtenção 

das variáveis sócio-demográficas, médicas e odontológicas. 

 Na avaliação odontológica, os pacientes foram avaliados quanto à condição bucal: 

presença de doença periodontal, gengivite, padrão oclusal, presença de facetas de desgaste, 

número de dentes ausentes e palpação dos músculos mastigatórios. 

3.2 Avaliação da tomografia  

 Para avaliação de imageologia, foram utilizadas tomografias computadorizadas 

convencionais (CT) e tomografias computadorizadas de fixe cônico (CBCT), de acordo com 

os exames solicitados ou que os pacientes possuíam previamente à procura do serviço, 

respeitando um prazo máximo de até seis meses da realização do exame tomográfico em 

relação ao dia da procura do serviço. Independente do tipo de equipamento utilizado nas 

aquisicoes das imagens tomograficas, estas foram adquiridas e armazenadas no protocolo 

Digital Imaging and Communications in Medicine (DICOM) e, posteriormente, reconstruídas 

e analisadas no software livre ImageJ® (Software de domínio público - freeware - 

desenvolvido pelo National Institute of Health) com o qual foi possível analisar a densidade 

ossea, relacionando os limites de atenuação dos feixes de raios X com os valores de níveis de 

cinza na área onde foram colocados os implantes nas regiões do complexo maxilo-mandibular 

nos pacientes envolvidos neste trabalho. 

 Para avaliação da densidade óssea antes da colocação do implante, foram 

utilizadas imagens previamente adquiridas pelos pacientes em diversos serviços de 

diagnóstico por imagem. Desta forma, não foi possível obter um padrão no protocolo de 

aquisição nas imagens de avaliação pré-cirúrgica (iniciais). Esta escolha está embasada no 
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princípio da radioproteção, ao qual não seria justificável solicitar repetição de exame em 

radiação ionizante visto que o paciente já o havia realizado para outros fins. 

 Estes exames de imagem foram utilizados para avaliar a indicação de implantes 

curtos na região posterior tanto da maxila como da mandíbula. Além disso, as tomografias 

serviram para avaliar a qualidade óssea através de dois métodos: seguindo o critério de 

avaliação visual e tátil de qualidade óssea proposto por Lekholm e Zarb (1985), através da 

avaliação visual dos cortes tomográficos na região de interesse de colocação para cada 

implante, realizado por um cirurgião-dentista radiologista experiente; e o segundo método de 

avaliação de qualidade óssea foi realizado através do cálculo da média dos tons de cinza da 

região do implante para determinar a sua densidade óptica, como relatado anteriormente. 

Ambos métodos foram feitos com o auxílio do programa de computador ImageJ.  

 Com o intuito de manter os cirurgiões (DFT e FRA) cegados durante a cirurgia de 

colocação de implante e a própria avaliação tátil in situ da qualidade óssea, as avaliações de 

qualidade óssea realizadas nas imagens tomográficas foram feitas após a colocação do 

implante, visto que estes cirurgiões participaram e coordenaram estas avaliações junto com o 

cirurgião-dentista radiologista e com o físico que participaram como avaliadores dos exames. 

Desta forma, os cirurgiões-dentistas que operaram os pacientes não sabiam qual tipo ósseo foi 

definido na tomografia para a região de colocação do implante antes da cirurgia. 

 

3.2.1 Determinação da posição do implante para avaliação na tomografia  

 Para estabelecer a região do implante colocado, foi realizada uma radiografia 

periapical digital para cada implante no dia da remoção de suturas.  

 Por sua vez, na tomada da imagem radiográfica digital foi utilizado o aparelho de 

raioX Gnatus Timex 70C®, o sensor digital Owandy Krystak X Easy® e o software Owandy 

Quick Vision®, sendo o tempo de exposição de 0,12s para a região dos molares superiores e 

de 0,10s para a região dos molares inferiores e pré-molares superiores e inferiores. 

 Com intuito de padronizar as radiografias, foram utilizados posicionadores Rinn 

XCP® com Bite Blocks (Rinn XCP Post Bite Block n° 54-0862) adaptados para o sensor 

digital (Fig. 3, 4, 5 e 6). 

Nesta radiografia foi realizada uma medição da face proximal do dente mais 

próximo ao implante até o centro do mesmo com o auxílio do programa de computador 

utilizado para visualizar a imagem radiográfica do sensor intra-oral. Esta medida foi utilizada 
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no exame tomográfico para determinar a área de interesse para avaliação da qualidade óssea 

visual e a densidade óptica em tons de cinza (Fig. 7). 

 

Figura 3, 4, 5, 6: Etapas da adaptação dos bite blocks para o sensor digital.  

 

 

 

Nota: Acima a direita (3) e acima à esquerda (4) áreas pintadas para o recorte. Abaixo à esquerda recortes 

realizados (5). Adaptação do sensor ao bite block (6). 

 

 As medidas da posição de cada implante foram tabuladas em uma planilha excel 

para serem utilizadas posteriormente nas análises de qualidade óssea de cada região onde foi 

colocado o respectivo implante nas tomografias. 
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Figura 7: Medição da posição do implante tendo como referência o dente adjacente  

e o centro aproximado do implante. 
 

 
 

 

3.2.2 Análise da qualidade óssea através da densidade óptica dos tons de cinza da imagem 

tomográfica  

 Para avaliar a qualidade óssea através da tomografia computadorizada pré-

cirúrgica foi usado o programa de computador para edição de imagens ImageJ®, onde foi 

analisada a densidade óptica da imagem do osso da região onde foi colocado cada implante 

(região de interesse, ou region of interest - ROI) através da média de tons de cinza da 

respectiva região nos cortes sagital, axial e coronal e, após obter a média e desvio-padrão dos 

tons de cinza de cada corte, foi realizada a média e o desvio-padrão destas três médias de tons 

de cinza para representar a densidade óptica em tons de cinza da imagem óssea da respectiva 

região onde foi colocado o implante.  

 Na avaliação da densidade óssea, em função dos níveis de cinza das imagens 

disponíveis, foi realizado um processamento matemático, ao qual todas as imagens foram 

convertidas para 8bits (256 níveis de cinza). Desta forma, foi possível padronizar os valores 

de níveis de cinza, que variam numa escala de 0 a 255 (Fig. 8), onde 0 representa valores 

escuros dentre os níveis de cinza da imagem, que correspondem à menor atenuação dos feixes 

de raios X no momento da exposição e 255 representa valores claros a brancos dentre os 

níveis de cinza, que correspondem à maior atenuação dos feixes de raios X, dependendo do 

tipo do tecido irradiado. 
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Figura 8: Representação gráfica da escala de tons de cinza em imagens em 8 bits. 

 

 

 

 O corte tomográfico para medição da densidade óptica era obtido a partir dos 

dados registrados das radiografias pós-operatórias dos implantes, cujo método de obtenção da 

medida foi relatado anteriormente. Este dado era transferido para cada corte tomográfico 

tendo como ponto de referência o dente mais próximo ao implante em questão para análise. A 

transferência desta medida de posição para as tomografias ocorreu de maneira diferente para 

cada corte analisado e será descrito a seguir. 

3.2.2.1 Análise da densidade óptica no corte axial  

- No ImageJ®, selecionou-se File > Import > Image Sequence (Fig. 9); abriu-se 

uma janela para seleção do arquivo DICOM (Fig. 10), após a seleção do arquivo, selecionou-

se as opções de ajuste da sequência de imagens e clicou-se em Ok (Fig. 11 e 12);  



38 

 

Figura 9: Ferramentas para importação dos dados para reconstrução da imagem tomográfica.  

 

  
 

 

Figura 10: Janela para seleção da sequência de arquivos DICOM.  
 

 
 

 

 



39 

 

 

 

 

Figura 11 e 12: Ajustes da reconstrução à esquerda (11) e imagem reconstruída à direita (12). 

 

       
 
 

A sequência de imagens de cortes axiais foi aberta automaticamente e padronizou-se em 8bits a 

reconstrução utilizando os comandos image > file > 8bit (Fig. 13);  
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Figura 13: Seleção de imagem em 8 bits.  
 

 
 

 

 Escolheu-se um corte axial que mostrava as raízes dentárias e o rebordo ósseo onde foi 

colocado o implante; selecionou-se o ícone de ferramenta Straight (Fig. 14);  

 

Figura 14: Seleção da ferramenta para realizar a reta. 

 

 
 

 Foi feita uma reta (cuja medida o programa informa instantaneamente) de comprimento 

igual ao da medida da localização do implante em questão (calculada anteriormente 

através do método já citado, com o auxílio das radiografias periapicais digitais – Fig. 7), 

paralelamente e ao lado do rebordo ósseo, partindo do ponto de referência (dente 

adjacente) e sendo o seu final a região aproximada do centro do implante; em seguida 

era realizado o comando control D para fixar esta reta na imagem; mais uma reta era 

traçada com comprimento de 6mm e depois o centro desta reta era posicionado no fim 

da reta anterior, paralelamente à primeira e ao rebordo, servindo de referência para o 
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próximo passo, ficando 3mm para cada lado da posição aproximada do centro do 

implante colocado na área em análise; 

 Selecionou-se a ferramenta Wand (tracing) (Fig. 15) para delimitar a área de interesse 

ou ROI (region of interest), com a qual era contornada a imagem do rebordo no limite 

externo das corticais com o comprimento de 6mm dado pela linha de referência 

marcada ao lado do rebordo, sendo que a figura geométrica formada tinha seu perímetro 

fechado com as outras duas faces cruzando perpendicularmente sobre a imagem do osso 

medular (Fig. 16); 

 

Figura 15: Seleção da ferramenta para contorno da ROI.  

 

 
 

 

Figura 16: ROI (perímetro amarelo) no corte axial para medição da densidade ópitica. Linha 

preta mais medial corresponde à transferência da medida de posição do centro do 

implante. Linha preta mais lateral corresponde aos 6mm para referência no 

delineamento da ROI. 

 

 
 

 



42 

 

 - Então era determinado quais as medições que seriam realizadas pelo programa, 

selecionandodo-se o caminho Analyze > Set measurements (Fig. 17);  

 

Figura 17: Caminho para configuração dos dados a serem calculados pelo software 
 

 
. 

 

- Abria-se automaticamente uma janela onde era realizada a seleção dos dados a 

serem calculados (Fig. 18); 

 

Figura 18: Janela para seleção dos dados a serem calculados.  
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 Os dados eram calculados pelo programa realizando o comando control M ou 

selecionando-se o caminho Analyze > Measure (Fig. 19); 

 

Figura 19: Ferramenta para iniciar o cálculo dos dados na ROI selecionada.  

 

 
 

 Os dados eram registrados em uma tabela própria do ImageJ®; 

 O processo era repetido para o próximo implante até serem realizadas todas as medições 

de densidade óptica do corte axial, e a partir da tabela do ImageJ® que armazenava estes 

dados, que eram transferidos para uma planilha Excel através dos comandos File >Save 

As (Fig. 20). 

 

Figura 20: Planilha com os dados no ImageJ® e o caminho exportar os dados para uma 

planilha excel. 
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3.2.2.2 Análise da densidade óptica no corte coronal  

 No ImageJ®, selecionou-se File > Import > Image Sequence (Fig. 9);  

 Abriu-se uma janela para seleção do arquivo DICOM (Fig. 10), após a seleção do 

arquivo, selecionou-se as opções de ajuste da sequência de imagens e clicou-se em Ok 

(Fig. 11 e 12);  

 A sequência de imagens de cortes axiais foi aberta automaticamente e padronizou-se em 

8bits a reconstrução utilizando os comandos image > file > 8bit (Fig. 13);  

 Foi escolhido um corte axial que mostrava as raízes dentárias e o rebordo ósseo onde foi 

colocado o implante; selecionou-se o ícone de ferramenta Straight (Fig. 14); 

 Foi feita uma reta (cuja medida o programa informa instantaneamente) de comprimento 

igual ao da medida da localização do implante em questão (calculada anteriormente 

através do método já citado, com o auxílio das radiografias periapicais digitais – Fig. 7), 

paralelamente e ao lado do rebordo ósseo, partindo do ponto de referência (dente 

adjacente) e sendo o seu final a região aproximada do centro do implante; em seguida 

era realizado o comando control D para fixar esta reta na imagem. Esta linha de 

referência foi utilizada para traçar outra linha perpendicular ao rebordo (Fig. 21); 

 

Figura 21: Seleção da região aproximada da colocação do implante para reconstrução do 

corte coronal. 
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 Para reconstrução do corte coronal, a partir da reta delimitada anteriormente, foi 

selecionado a seguinte sequência de comandos Image>Stacks>Reslice[/] (Fig. 22); 

 

Figura 22: Sequência de comandos para reconstrução do corte coronal de interesse. 

 

 
 

 

 Automaticamente  foi reconstruída a imagem do corte coronal em outra janela onde foi 

selecionada a ferramenta Straight (Fig. 14) e delimitada uma reta de 6mm de 

comprimento, paralela ao eixo da cortical (vestibular ou palatina/lingual) do rebordo 

alveolar e tendo como ponto de início desta reta a crista do rebordo alveolar. Então foi 

fixada na imagem esta linha com o comando control D. Foi selecionado a ferramenta 

Wand (tracing) (Fig. 15) para delimitar a área de interesse ou ROI (region of interest), 

com a qual era contornada a imagem do rebordo no limite externo das corticais com a 

altura de 6mm dado pela linha de referência marcada ao lado do rebordo, sendo que a 
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Figura geométrica formada tinha seu perímetro fechado com uma linha 

perpendicularmente às corticais vestibular e palatina/lingual sobre a imagem do osso 

medular (Fig. 23); 

 

Figura 23: Delimitação da ROI para análise da densidade óptica. 

 

 
 

 

 Outra vez era determinado quais as medições que seriam realizadas pelo programa 

selecionando-se o caminho Analyze > Set measurements (Fig. 17); 

 Abria-se automaticamente uma janela onde era realizada a seleção dos dados a serem 

calculados (Fig. 18); 

 Os dados eram calculados pelo programa realizando o comando control M ou 

selecionando o caminho Analyze > Measure (Fig. 19); 

 Os dados eram registrados em uma tabela própria do ImageJ®; 

 O processo era repetido para o próximo implante até serem realizadas todas as medições 

de densidade óptica do corte axial, e a partir da tabela do ImageJ® que armazenava estes 

dados, que eram transferidos para uma planilha Excel através dos comandos File > Save 

As (Fig. 20). 

3.2.2.3 Análise da densidade óptica no corte sagital  

 No ImageJ, selecionou-se File > Import > Image Sequence (Fig. 9);  
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 Abriu-se uma janela para seleção do arquivo DICOM (Fig. 10), após a seleção do 

arquivo, selecionou-se as opções de ajuste da sequência de imagens e clicou-se em Ok 

(Fig. 11 e 12);  

 A sequência de imagens de cortes axiais foi aberta automaticamente e padronizou-se em 

8bits a reconstrução utilizando os comandos image > file > 8bit (Fig. 13);  

 Foi escolhido um corte axial que mostrava as raízes dentárias e o rebordo ósseo onde foi 

colocado o implante; selecionou-se o ícone de ferramenta Straight (Fig. 14); 

 Foi feita uma reta sobre o centro do rebordo e, a partir desta reta, foi gerado outro corte 

no sentido sagital (Fig. 24), através da seguinte sequência de comandos: Stacks > 

Reslice [/] > confimou-se os ajustes de reslice e clicou-se em Ok (Fig. 22);  

 

Figura 24: Seleção da reta sobre o centro do rebordo alveolar que determinou  

a geração do corte sagital. 

 

 

 

 Neste novo corte sagital, que se abre automaticamente em outra janela, 

selecionou-se a ferramenta Straight (Fig. 14) e tranferiu-se mais uma vez a medida de 

localização aproximada do implante (calculada anteriormente através do método já 

citado, com o auxílio das radiografias periapicais digitais – Fig. 7) para o corte 
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tomográfico em milímetros, do ponto de referência em questão ao centro do implante 

colocado; foi feito o comando Control D para marcar esta reta sobre a imagem do 

rebordo (Fig. 25);  

 

Figura 25: Imagem da reta de transferência da posição do implante.  

 

   

 

- Selecionou-se a ferramenta Rectangular (Fig. 26);  

 

Figura 26: Seleção da ferramenta para determinar uma ROI quadrada.  

 

 
 

 Realizou-se uma ROI (region of interest, ou região de interesse) de 6mm x 6mm para 

representar a área do implante e 1mm de osso de cada lado do implante; posicionou-se 

este quadrado dentro da imagem do tecido ósseo, sendo que o seu centro correspondeu a 

uma linha perpendicular à linha marcada sobre o rebordo; a área deste quadrado foi 
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utilizada para calcular a densidade óptica do osso onde foi colocado o implante para o 

corte sagital (Fig. 27);  

 

Figura 27: Imagem da posição da ROI quadrada (6mm x 6mm) para determinar  

a densidade óptica. 

 

 

 

 Novamente era determinado quais as medições que seriam realizadas pelo programa 

selecionando-se o caminho Analyze > Set measurements (Fig. 17); 

 Abria-se automaticamente uma janela onde era realizada a seleção dos dados a serem 

calculados (Fig. 18); 

 Os dados eram calculados pelo programa realizando o comando control M ou 

selecionando o caminho Analyze > Measure (Fig. 19); 

 Os dados eram registrados em uma tabela própria do ImageJ; 

 O processo era repetido para o próximo implante até serem realizadas todas as medições 

de densidade óptica do corte axial, e a partir da tabela do ImageJ que armazenava estes 

dados, que eram transferidos para uma planilha Excel através dos comandos File > Save 

As (Fig. 20). 

 

3.2.3 Avaliação da qualidade óssea através da análise visual dos cortes tomográficos 

 A avaliação visual e subjetiva da qualidade óssea feita por um radiologista 

experiente, também foi realizada com o auxílio do ImageJ® e a determinação da área de 
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avaliação foi da mesma forma que a utilizada para determinação da densidade óptica, ou seja, 

foi utilizada a medida obtida na radiografia periapical digital do pós-operatório para 

determinar a região aproximada do centro do implante colocado (Fig. 7).  

 Desta forma, a avaliação visual foi realizada considerando-se as características 

ósseas da região onde foi colocado o implante através da análise da imagem tomográfica em 

cortes no sentido axial, sagital e coronal do exame pré-cirúrgico. Após a avaliação visual 

destes cortes, o observador classificou o osso em questão em relação ao tipo de qualidade 

óssea (Fig. 28), de acordo com a classificação de Lekholm e Zarb (1985): 

 Osso tipo 1: Cortical óssea envolvendo praticamente toda a área óssea e 

pouco osso trabecular. 

 Osso tipo 2: Cortical óssea espessa e trabeculado ósseo denso. 

 Osso tipo 3: Cortical óssea fina e trabeculado ósseo denso. 

 Osso tipo 4: Cortical óssea fina e trabeculado ósseo rarefeito. 

Figura 28: Desenho esquemático adaptado de Lekholm e Zarb (1985) para classificar 

visualmente o osso nos exames de imagens e tatilmente durante a fresagem 

cirúrgica para a colocação de implante. A numeração abaixo do desenho 

esquemático corresponde ao tipo ósseo da classificação. 

1 2 3 4 

 Para visualizar os corte tomográficos foi utilizado uma tela de fundo preto 

preparado no programa PowerPoint e sobre este eram abertas as janelas do programa 

ImageJ®. 

 Primeiramente era aberta a imagem do respectivo implante em análise da seguinte 

forma: 

 No ImageJ®, selecionava-se File > Import > Image Sequence (Fig. 9); abria-se uma 

janela para seleção do arquivo DICOM (Fig. 10) e, após a seleção do arquivo, 

selecionava-se as opções de ajuste da sequência de imagens (Fig. 11 e 12); 
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 Automaticamente abriu-se a janela com a sequência de cortes axiais. Padronizou-se em 

a reconstrução em 8 bits utilizando os comandos image > file > 8bit (Fig. 13). Então era 

selecionado um corte onde aparecia o rebordo e o dente adjacente que serviria de 

referência para a transferência da medida de localização aproximada do centro do 

implante colocado. Em seguida transferiu-se esta medida com auxílio da ferramenta 

Straight (Fig. 14), fazendo-se uma reta perpendicular à face proximal do dente de 

referência até atingir o comprimento da posição aproximada do centro do implante. Esta 

região era analisada visual e individualmente, da cortical externa vestibular até a 

cortical externa lingual/palatina, numa distância de cerca de 3mm para cada lado da 

posição aproximada do centro do implante. A posição a ser avaliada era memorizada e 

as linhas eram apagadas para a análise visual para não confundir o examinador (Fig. 

29); 

 

Figura 29: Imagem para análise visual da qualidade óssea no corte tomográfico axial na 

região do dente 26, segundo Lekholm e Zarb (1985). 

 

 
 

 A partir da determinação do centro do implante, era traçada uma reta perpendicular às 

corticais vestibular e lingual/palatina do rebordo em análise (Fig. 21), com o auxílio da 

ferramenta Straight (Fig. 14). Então utilizavam-se os comandos 

Image>Stacks>Reslice[/] (Fig. 22) para gerar a imagem do corte coronal para a análise 

de qualidade óssea visual; 

 Automaticamente abria-se outra janela com o corte coronal onde era realizada a análise 

visual da qualidade óssea levando-se em consideração a área óssea entre as corticais 
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externas vestibular e lingual/palatina e da crista do rebordo até 6mm de altura dentro do 

osso medular (Fig. 30). 

 

Figura 30: Corte coronal para avaliação visual da qualidade óssea  

segundo Lekholm e Zarb (1985). 

 

 
 

 Ainda a partir da imagem do corte axial, era traçada uma reta sobre o meio do rebordo 

(Fig. 24) com a ferramenta Straight (Fig. 14). Então utilizavam-se os comandos 

Image>Stacks>Reslice[/] (Fig. 22) para gerar a imagem do corte sagital; 

 Automaticamente abria-se mais uma janela, esta com o corte sagital onde era realizada a 

transferência da posição do centro do implante para servir de referência para a análise 

visual da qualidade óssea. Para tanto, selecionou-se a ferramenta Straight (Fig. 14) e 

tranferiu-se mais uma vez a medida de localização aproximada do implante (calculada 

anteriormente através do método já citado, com o auxílio das radiografias periapicais 

digitais – Fig. 7) para o corte tomográfico em milímetros, do ponto de referência em 

questão ao centro do implante colocado (Fig. 25); 

 Para a análise visual da qualidade óssea no corte sagital, era considerada a área 

compreendida entre a crista do rebordo até 6mm para dentro do osso medular e 3mm 

para cada lado da linha correspondente ao centro do implante. Estas posições eram 

memorizadas e as linhas de referências apagadas para a análise visual (Fig. 31). 
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Figura 31: Imagem do corte sagital para a análise visual da qualidade óssea  

segundo Lekholm e Zarb (1985). 

 

 
 

 Para a determinação visual da qualidade óssea de cada região onde foi colocado o 

implante em análise, o examinador analisou os cortes axial, sagital e coronal tantas 

vezes quanto julgou necessário para definir se o osso em questão era tipo 1, tipo 2, tipo 

3 ou tipo 4 segundo a classificação de Lekholm e Zarb (1985) utilizando a integração 

das informações visuais destes cortes para a formação subjetiva do grau de qualidade 

óssea. Esta informação era transferida para uma planilha Excel. 

 Em seguida, este processo era repetido para outra região onde foi colocado um 

implante, mesmo nos casos onde foram colocados mais de um implante (adjacentes ou 

não) no mesmo paciente e que se enquadrava nos critérios de inclusão desta pesquisa, 

visto que a análise foi realizada para cada região onde foi colocado implante. 

3.3 Protocolo cirúrgico e medições de estabilidade primária  

 Foram instalados 45 implantes Standard Plus Regular Neck SLActive® 

(Straumann AG, Basel, Switzerland) de 6 mm de comprimento em 20 pacientes, seguindo o 

protocolo de um estágio cirúrgico como recomendado pela empresa, atendidos em clínica 

particular na cidade de Porto Alegre, Rio Grande do Sul, Brasil (cirurgiões-dentistas Fernando 

Alonso, Diego Triches e Luis André Mezzomo). Após período de cicatrização óssea de três 

meses, foram realizadas coroas metalocerâmicas aparafusadas unitárias nestes implantes. 
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 Antes do procedimento cirúrgico, foi realizada assepsia da face e da cavidade oral 

com clorexidina 0,12%, através da aplicação com gaze e de bochecho de um minuto, 

respectivamente. 

 O procedimento cirúrgico de instalação do implante foi realizado sob anestesia 

local com cloridrato de articaína a 4% com adrenalina 1:100.000 (Articaine®, DFL, Rio de 

Janeiro, Brasil). Foi realizada incisão sobre a crista do rebordo e descolamento total do retalho 

(Fig. 32 e 33). Quando necessárias foram feitas incisões relaxantes.  

 

Figura 32: Incisão sobre a crista do rebordo.  

 

 

 

 

Figura 33: Descolamento total do retalho. 
 

 

 

 Com o auxílio de um contra-angulo Kavo 16:1 (Kavo Dental®, Biberach, 

Alemanha) acoplado em um motor elétrico Smart® (Driller, Jaguaré, São Paulo, Brasil) 
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seguiu-se a sequência de fresagem cirúrgica (Fig. 34, 35, 36, 37 e 38) preconizada pela 

empresa (broca esférica 1.4mm, broca esférica 2.3mm, broca helicoidal 2.2mm, broca 

helicoidal 2.8mm e broca helicoidal 3.5mm), porém sem a utilização da broca de perfil e do 

promotor de rosca, para propiciar uma melhor estabilidade primária. A velocidade de rotação 

para a perfuração do sítio cirúrgico foi de 900 rpm. 

 

Figura 34, 35, 36, 37 e 38: Sequência de fresagem cirúrgica para  

                                              implante de diâmetro 4.1 mm.  

 

   

   

 

Notas:  

À esquerda acima, broca esférica 1.4 mm (34).  

À direita acima, broca esférica 2.3 mm(35).  

À esquerda no meio, broca helicoidal 2.2 mm (36).  

À direita no meio, broca helicoidal 2.8 mm (37).  

Abaixo, broca helicoidal 3.5 mm (38). 
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A instalação do implante foi realizada através do contra-ângulo, com o auxílio do 

adaptador, em uma velocidade de 18 rpm (Fig. 39, 40, 41 e 42). O implante foi inserido até o 

limite entre a superfície tratada das roscas e a superfície lisa da plataforma. 

 

Figura 39, 40, 41 e 42  Instalação do implante Straumann SLActive RN SP 4.1x6 mm 

utilizando contra-ângulo.  
 

   

   

 

Notas: À esquerda acima, remoção do implante do recipiente (39). À direita acima, visualização do implante 

(40). À esquerda abaixo, instalação do implante (41). À direita abaixo, implante instalado com o montador (42). 

 

 

 Logo após a colocação do implante, o torque de inserção foi medido através do 

uso do torquímetro manual (Straumann Dental Implant System®, Waldenburg, Suíça) 

acoplado à catraca manual (Straumann Dental Implant System®, Waldenburg, Suíça), sendo 

que a medida foi classificada em três categorias em Newton por centímetro: < 15 Ncm, de 15 

Ncm a 35 Ncm e > 35 Ncm (Fig. 43). 
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Figura 43: Avaliação da estabilidade primária utilizando o torquímetro manual. 

 

 

 Em seguida, era realizada a medição da capacidade de amortecimento do conjunto 

osso e implante através do aparelho Periotest® (Medizintechnik Gulden, Eschenweg, 

Alemanha) em valores de periotest (PTV). Para esta medição, o batente era posicionado na 

face vestibular do montador, na sua porção mais cervical e próxima do implante, 

perpendicular ao solo e em 90° em relação ao eixo do implante, a uma distância de 

aproximadamente 2 mm do montador. Então o aparelho era acionado e era feito o registro da 

medida em PTV (Fig. 44 e 45). 

 

Figura 44 e 45: Avaliação da estabilidade primária com medição da capacidade de  

amortecimento (valores PTV) utilizando o aparelho Periotest®.  

 

   

Nota: À esquerda, aparelho pronto para o uso (44). À direita, medição sendo realizada (45). 

 

 Após a remoção do montador, era realizada a medição da análise da freqüência de 

ressonância através do OsstellTM (Integration Diagnostics AB®, Gotemburgo, Suécia). Para 



58 

 

tanto, era colocado o SmartPeg (Integration Diagnostics AB®, Gotemburgo, Suécia), 

específico para o implante que foi colocado, com o auxílio da chave digital do aparelho e 

dado torque manual com cerca de 5Ncm (Fig. 46 e 47). Em seguida a sonda do aparelho era 

aproximada do SmartPeg, sem tocá-lo, e realizada uma medição no sentido vestíbulo-

palatino/lingual e em seguida outra medição era realizada no sentido mésio-distal. Os dados 

destas medidas eram registrados pelo aparelho em quoeficiente de estabilidade do implante 

(ISQ) e, a partir destas medidas, era calculada a média da medida no sentido vestíbulo-

palatino/lingual com a medida no sentido mésio-distal como o dado para ser avaliado na 

análise estatística (Fig. 48, 49 e 50). 

 

Figura 46 e 47: Smartpeg na embalagem e Instalação do respectivo Smartpeg  

 

   

Nota:  

À esquerda, Smartpeg na embalagem (46).  

À direita, Instalação do respectivo Smartpeg
®

 com a chave manual para a medição da frequência de ressonância 

(47). 
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Figura 48, 49 e 50: Avaliação da estabilidade primária por medição da frequência de 

ressonância utilizando o aparelho OsstellTM.  

 

   

 

Nota: À esquerda acima, aparelho pronta para uso (48).  

À direita acima, medição da estabilidade no sentido mésio-distal (49).  

Abaixo, medição da estabilidade no sentido vestíbulo-palatino (50). 

 

 Em seguida, instalou-se a tampa de cicatrização e a sutura foi realizada com fio de 

nylon 4.0 (Fig. 51 e 52). Após a cirurgia todos os pacientes foram medicados com antibiótico 

(Amoxicilina 500 mg de 8 em 8 horas durante 7 dias), antiinflamatório (Nimesulida 100 mg 

de 12 em 12 horas durante 4 dias) e orientados a fazer bochechos com digluconato de 

clorexidina 0,12% durante 15 dias. As suturas foram removidas após 7 a 10 dias da cirurgia. 

Adotou-se o protocolo de cicatrização dos implantes de um estágio cirúrgico.  
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Figura 51 e 52: Cirurgia de instalação do implante finalizada com a colocação da tampa de 

cicatrização e sutura. 

   

Nota: À esquerda, vista vestibular (51). À direita, vista oclusal (52). 

3.4 Avaliação cirúrgica da qualidade óssea  

 Durante a fresagem cirúrgica do osso para a colocação do implante o cirurgião era 

questionado quanto a sua sensação tátil de qualidade óssea de acordo com a classificação de 

Lekholm e Zarb (1985). Para realizar esta medida subjetiva, o cirurgião deveria, através do 

tato no momento da fresagem, levar em consideração a espessura da cortical óssea e a 

resistência do osso trabecular ao corte, e responder se o osso se enquadrava em uma das 

quatro categorias (Fig. 28): 

 Osso tipo 1: Cortical óssea envolvendo praticamente toda a área óssea e 

pouco osso trabecular. 

 Osso tipo 2: Cortical óssea espessa e trabeculado ósseo denso. 

 Osso tipo 3: Cortical óssea fina e trabeculado ósseo denso. 

 Osso tipo 4: Cortical óssea fina e trabeculado ósseo rarefeito. 

3.5 Análise estatística 

Foi realizada uma análise dos dados descritivos dos critérios de inclusão e 

exclusão da população da amostra e da quantidade de implantes colocados por paciente. A 

coleta dos dados levou em consideração cada implante colocado. 

 Através do Teste t, com nível de significância de 5%, foi avaliada a diferença 

entre as médias de ISQ e os níves de PTV (entre -8 a 0 e entre 1 a 9). 

 Foi utilizado o teste Qui-quadrado, complementado pela Análise de Resíduos 

Ajustados, ao nível de significância de 5%, para avaliar a associação entre os níveis de PTV e 
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os níveis de torque de inserção e para avaliar a associação entre os níveis de torque de 

inserção e a qualidade óssea avaliada cirurgicamente. Estes testes também foram utilizados 

para avaliar a associação entre os níveis de torque de inserção e a qualidade óssea avaliada 

cirurgicamente. 

 O teste de Análise de Variância, complementado pelo teste de comparações 

múltiplas de Tukey, ao nível de significância de 5% foi utilizado para verificar a diferença das 

médias de ISQ em relação aos níveis de torque de inserção, em relação à qualidade óssea 

visual da tomografia e em relação à qualidade óssea cirúrgica. 

 Também foi utilizado o teste de Análise de Variância, complementado pelo teste 

de comparações múltiplas de Tukey, ao nível de significância de 5%, para verificar a 

diferença das médias de Densidade Óptica em relação à qualidade óssea visual da tomografia 

e em relação à qualidade óssea cirúrgica. 

 O Teste Não-paramétrico Kruskal Wallis complementada pelo seu Teste de 

Comparações Múltiplas, ao nível de significância de 5%, foi utilizado para avaliar os valores 

de PTV em relação às classificações de qualidade óssea visual da tomografia e em relação às 

classificações da qualidade óssea cirúrgica. 

 Por fim foi utilizado o teste de correlação de Spearman, ao nível de significância 

de 5%, para avaliar a correlação entre os métodos de avaliação da estabilidade primária dos 

implantes, a correlação entre os métodos de avaliação da qualidade óssea e entre a densidade 

óptica e todas as outras variáveis deste estudo. 
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4 RESULTADOS 

 Para formação do grupo de pacientes da pesquisa, foram triados 31 pacientes de 

uma amostra de conveniência (pacientes que procuraram o serviço e que potencialmente 

teriam indicação de implantes curtos unitários na região posterior), onde 20 foram incluídos 

na pesquisa e 11 excluídos. Dos excluídos, seis foram por desistência do paciente em 

participar da pesquisa, um por ter feito uso de bisfosfonatos, dois por terem altura óssea que 

permitia a colocação de implantes de altura maior que 6 mm e dois por serem usuários de 

prótese total ou de prótese parcial removível na arcada antagonista à área edêntula avaliada 

para a colocação do implante curto (Fig. 53). 

 

Figura 53: Relação dos pacientes incluídos e excluídos a partir de triagem realizada em 

amostra de conveniência. 

 

 

 

 Nos pacientes incluídos na pesquisa foram colocados ao todo 45 implantes 

(SLActive® RN SP ø4.1 x 6 mm), onde foram colocados de um a cinco implantes curtos em 

região posterior da maxila ou da mandíbula em cada paciente (Fig. 54). Destes, um implante 

ficou instável no momento da colocação, apresentando movimentos no sentido lateral, no 

sentido do longo eixo do implante e rotatório. Foi decidido pela retirada do implante para 
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aguardar neoformação óssea e pela colocação de outro implante, cujos dados não entraram na 

análise estatística.  

Figura 54: Número de pacientes em relação à quantidade de implantes  

colocados em cada paciente. 

 

 

 

 A estabilidade primária dos implantes medida com Periotest® teve mediana e 

intervalo interquartil de -1,0 (-4,0 ; 2,5) e com o Osstell® teve média e desvio padrão de 67,35 

(+/- 8,05) ISQ, variando de 79,5 a 41,5 ISQ. 

 As medidas de estabilidade primária foram comparadas com qualidade óssea. Da 

mesma forma foram correlacionados os três métodos de avaliação da qualidade óssea 

utilizados, assim como foram feitas análises estatísticas entre os métodos de medição da 

estabilidade inicial. 

 Como apenas um dos implantes foi instalado em osso do tipo 1, ele foi alocado no 

mesmo grupo dos implantes colocados em osso tipo 2 por razões estatísticas.  

 Para análise estatística alguns dados foram perdidos, a saber: um implante ficou 

com mobilidade após sua colocação no leito cirúrgico e foi removido, no qual não foram 

realizadas as medições desta pesquisa (neste local outro implante foi colocado após 90 dias 

mas também não entrou na estatística); uma medição do Periotest® não pode ser registrada por 

dificuldade de alcançar 90o da peça de mão com o eixo do implante e paralelismo ao solo; um 
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exame tomográfico da maxila de um paciente, onde foram colocados dois implantes a serem 

avaliados na pesquisa, teve erro de aquisição da imagem causando distorção das imagens que 

inviabilizaram as análises, mas foi possível planejar a colocação dos referidos implantes que 

foram utilizados para avaliação da estabilidade primária; três pacientes, cada um com dois 

implantes referentes à pesquisa, cujos dados de avaliação de qualidade óssea nas tomografias 

não puderam ser realizados, pois perderam-se os discos compactos com os arquivos DICOM e 

o serviço de radiologia não possuía mais os backups dos arquivos. 

 Através da Análise de Variância complementada pelo Teste de Comparações 

Múltiplas de Tukey, ao nível de significância de 5%, verificou-se não haver diferença na 

média dos níveis de cinza em relação aos escores de qualidade da tomografia; quanto aos 

escores da qualidade cirúrgica observa-se que a média dos níveis de cinza na classificação 3 

foi significativamente maior do que na classificação 4 (Tab. 1). 

 

Tabela 1: Densidade óptica (média das médias de níveis de cinza dos cortes) x Qualidade 

Óssea Visual da Tomografia e Qualidade Óssea Cirúrgica.  

Tipo de Osso 

Densidade Óptica 

Qualidade Óssea Visual da Tomografia Qualidade Óssea Cirúrgica 

Média DP Média DP 

1 – 2 124,86 A 33,68 101,28 AB 23,60 

3 96,81 A 29,98 118,76 A 28,90 

4 106,21 A 19,81 90,22 B 24,40 

P 0,111 0,027 

Nota: Médias seguidas de letras distintas na coluna diferem significativamente através da Análise de Variância 

complementada pelo Teste de Comparações Múltiplas de Tukey, ao nível de significância de 5%. 

 

 Através da Análise de Variância complementada pelo Teste de Comparações 

Múltiplas de Tukey, ao nível de significância de 5%, verificou-se a média de ISQ no torque 0-

15 foi significativamente menor do que nos demais níveis de torque (Tab. 2). 

 

Tabela 2: ISQ x Torque. 

Torque 
ISQ 

Média DP 

0 – 15 62,18 B 6,94 

15 – 35 69,47 A 7,80 

>35 71,92 A 6,04 

Nota: Análise de Variância: p= 0,01 

Médias seguidas de letras distintas na coluna diferem significativamente através da Análise de Variância 

complementada pelo Teste de Comparações Múltiplas de Tukey, ao nível de significância de 5%. 
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 Através do Teste T, com p=0,001, verificou-se que a média de ISQ quando o PTV 

está entre -8 a 0 é significativamente maior do que no PTV entre 1 a 9 (Tab. 3). 

 

Tabela 3: PTV x ISQ.  

PTV N 
ISQ 

p 
Média DP 

-8 a 0 26 70,13 6,02 
0,001 

1 a 9 17 62,29 8,31 

Nota: Teste T 

 

 Através do Teste Qui-quadrado complementado pela Análise de Resíduos 

Ajustados, ao nível de significância de 5%, verificou-se que o osso tipo 1-2 está localmente 

associado ao Torque >35 e o osso tipo 4 está associado ao torque 0-15 (Tab. 4). 

 

Tabela 4: Torque x Qualidade Óssea Cirúrgica. 

Torque 

Qualidade Óssea Cirúrgica 
Total 

1 - 2 3 4 

N % n % n % N % 

0 – 15 0 0,0 6 28,6 11 78,6* 17 38,6 

15 – 35 2 22,2 10 47,6 3 21,4 15 34,1 

>35 8 77,8* 5 23,8 0 0,0 12 27,3 

Total 9 20,5 21 47,7 14 31,8 44 100 

Nota: 2= 24,29; p<0,001 

*Análise de Resíduos Ajustados: p<0,05 

 

 Através do Teste Qui-quadrado complementado pela Análise de Resíduos 

Ajustados, ao nível de significância de 5%, verificou-se que a medida -8 a 0 do PTV está 

localmente associado ao Torque >35 e a medida 1 a 9 está associado ao torque 0-15 (Tab. 5). 

 

Tabela 5: Torque x PTV. 

Torque 

PTV 
Total 

-8 a 0 1 a 9 

N % n % n % 

0 – 15 6 35,3 11 64,7* 17 39,5 

15 – 35 9 64,3 5 35,7 14 32,6 

>35 11 91,7* 1 8,3 12 27,9 

Total 26 60,5 17 39,5 43 100 

Nota: 2= 9,48; p=0,009 

*Análise de Resíduos Ajustados: p<0,05 
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 Através da Análise de Variância complementada pelo Teste de Comparações 

Múltiplas de Tukey, ao nível de significância de 5%, verificou-se não haver diferença na 

média de ISQ em relação aos escores de qualidade óssea visual da tomografia; quanto aos 

escores da qualidade cirúrgica observa-se que a média de ISQ na classificação 4 foi 

significativamente menor do que na classificação 1-2 e 3 (Tab. 6). 

 

Tabela 6: ISQ x qualidade óssea visual da tomografia e qualidade óssea cirúrgica. 

Osso 

ISQ 

Qualidade Óssea Visual da Tomografia Qualidade Óssea Cirúrgica 

Média DP Média DP 

1 – 2 73,75 A 3,24 71,06 A 8,48 

3 67,62 A 8,90 70,24 A 4,24 

4 65,19 A 7,42 60,54 B 8,38 

P 0,097 <0,001 

Nota: Médias seguidas de letras distintas na coluna diferem significativamente através da Análise de Variância 

complementada pelo Teste de Comparações Múltiplas de Tukey, ao nível de significância de 5%. 

 

 Através do Teste Não-paramétrico Kruskal Wallis complementada pelo seu Teste 

de Comparações Múltiplas, ao nível de significância de 5%, verificou-se que na qualidade 

óssea visual da tomografia 1-2 os valores de PTV foram significativamente menores do que 

nas demais classificações de qualidade óssea visual da tomografia; quanto à qualidade óssea 

cirúrgica todas as classificações se diferiram entre si quanto aos níveis de PTV, sendo maior 

no nível 4, seguido do 3 e do 1-2 (Tab. 7). 

 

Tabela 7: Mediana e Intervalo Interquartil do PTV x Qualidade Óssea Visual da 

Tomografia e Qualidade Óssea Cirúrgica. 

Osso 

PTV 

Qualidade Óssea Visual da Tomografia Qualidade Óssea Cirúrgica 

Mediana (P25 ; P75) Rank médio Mediana (P25 ; P75) Rank médio 

1 – 2 -5,5 (-6,3 ; -1,5) 8,92 B -5,0 (-6,0 ; -2,5) 9,06 C 

3 -1,50 (-3,0 ; 1,8) 17,63 A -3,0 (-3,5 ; 1,5) 19,57 B 

4 0,0 (-3,0 ; 4,5) 22,65 A 2,5 (0,8 ; 5,3) 33,04 A 

P 0,023 <0,001 

Nota: p= Nível mínimo de significância do Teste Não-paramétrico Kruskal-Wallis 

Ranks médios seguidas de letras distintas, na coluna, diferem significativamente através do Teste Não-

paramétrico Kruskal Wallis complementada pelo seu Teste de Comparações Múltiplas, ao nível de significância 

de 5%. 
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 Através do teste de correlação de Spearman, ao nível de significância de 5%, 

verificou-se correlação moderada entre os três métodos de avaliação da estabilidade primária 

dos implantes, ou seja, entre torque de inserção e PTV, torque de inserção e ISQ e entre PTV 

e ISQ. Por outro lado, não houve correlação entre métodos de avaliação da qualidade óssea, 

exceto entre a avaliação visual da tomografia e a qualidade cirúrgica onde houve correlação 

estatisticamente significante (Tab. 8). 

Tabela 8: Correlaçao entre os métodos de avaliação de estabilidade primária e de 

qualidade óssea. 

 
Coeficiente de 

Correlação de Spearman 

Estabilidade 

Torque x ISQ 0,606* 

Torque x PTV -0,686* 

ISQ x PTV -0,627* 

Qualidade 

Visual da Tomografia x Cirúrgica 0,377* 

Visual da Tomografia x Densidade Óptica -0,053 

Cirúrgica x Densidade Óptica -0,159 
Nota: Correlação significativa ao nível de significância de 5% 

 

 Através do teste de correlação de Spearman, ao nível de significância de 5%, 

verificou-se não haver correlação entre a densidade óssea em tons de cinza e os outros 

métodos de avaliação da qualidade óssea, assim como não houve correlação entre a densidade 

óssea em tons de cinza e os métodos de avaliação da estabilidade primária dos implantes 

(Tab. 9). 
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Tabela 9: Correlação entre Densidade óptica e os métodos de avaliação da estadilidade 

primária e entre a Densidade óptica e os métodos de avaliação da qualidade óssea. 

Correlação de Spearman 

 

Níveis de 

cinza da ROI 

corte axial 

Níveis de 

cinza da ROI 

corte coronal 

Níveis de 

cinza da ROI 

corte sagital 

Níveis de 

cinza da ROI 

(média) 

 QOVT Correlation Coefficient -0,089 -0,071 0,064 -0,053 

Sig. (2-tailed) 0,606 0,680 0,711 0,758 

N 36 36 36 36 

Torque Correlation Coefficient 0,100 0,044 0,081 0,060 

Sig. (2-tailed) 0,562 0,799 0,637 0,730 

N 36 36 36 36 

ISQ Correlation Coefficient 0,057 0,025 0,088 0,025 

Sig. (2-tailed) 0,740 0,884 0,609 0,885 

N 36 36 36 36 

PTV Correlation Coefficient -0,140 -0,144 0,064 -0,100 

Sig. (2-tailed) 0,422 0,409 0,715 0,569 

N 35 35 35 35 

Qualidade 

óssea cirúrgica 

Correlation Coefficient -0,204 -0,170 -0,075 -0,159 

Sig. (2-tailed) 0,233 0,322 0,665 0,354 

N 36 36 36 36 

Nota: Correlação significativa ao nível de significância de 5% 
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5 DISCUSSÃO 

 Esta pesquisa analisou a influência da qualidade óssea na estabilidade primária em 

implantes curtos unitários em região posterior da maxila e da mandíbula avaliada por três 

métodos clínicos bastante utilizados: análise de frequência de ressonância ou RFA (em ISQ, 

através do Osstell®), capacidade de amortecimento (em PTV, através do Periotest®) e torque 

de inserção (em Ncm, através de torquímetro manual). Estes três métodos mostraram 

correlação moderada entre si e revelaram-se propícios para avaliação da estabilidade primária 

dos implantes. Os resultados deste trabalho sugeriram que no osso tipo 4, avaliado 

cirurgicamente, a estabilidade inicial dos implantes curtos é menor que os outros tipos ósseos. 

Foi encontrada correlação entre a avaliação visual da qualidade óssea tomográfica e a 

avaliação cirúrgica da qualidade óssea. Por outro lado, a avaliação da qualidade óssea através 

dos níveis de tons de cinza não teve correlação com a avaliação cirúrgica da qualidade óssea, 

nem com a avaliação visual da qualidade óssea tomográfica e nem associação com os 

métodos de avaliação da estabilidade primária dos implantes curtos. 

 A estabilidade inicial menor no osso tipo 4 pode ocasionar a micromovimentação 

do implante durante o período de cicatrização óssea a qual pode gerar falha da 

osseointegração (Lioubavina-Hack et al., 2006; Alsaadi et al., 2007; Alsaadi et al., 2008), já 

que a estabilidade secundária, que define o sucesso da osseointegração, está diretamente 

associada à estabilidade primária, como demonstrado em alguns estudos (Karl et al., 2008; 

Rossi et al., 2010; Sim e Lang, 2010). Trabalhos in vitro (Trisi e Rao, 1999; Trisi et al., 2009) 

também demonstraram que em osso menos denso os implantes tinham menor estabilidade e 

maior micromovimentação. Isto implica na atenção e cuidados extras do cirurgião no 

momento da colocação de implantes curtos neste tipo de osso, como evitar alargamento 

excessivo do sítio cirúrgico durante a fresagem óssea, a possibilidade de deixar o implante 

submerso - duas fases cirúrgicas - quando tiverem pouca estabilidade inicial, ou evitar carga 

imediata e carga precoce nestes casos.  

 Alguns estudos também têm mostrado tendência maior de falhas de 

osseointegração para  implantes colocados em osso tipo 4 ou de baixa densidade (Tawil e 

Younan, 2003; Feldman et al., 2004). Por exemplo, o estudo retrospectivo de Feldman e 

colaboradores (2004) que avaliou 4.891 implantes, onde 984 foram colocados em osso de 

baixa qualidade, com uma tendência menor de taxa de sobrevivência em cinco anos de 

implantes curtos colocados neste tipo ósseo, principalmente os implantes lisos. Da mesma 

forma, Arlin (2006), num estudo retrospectivo de 2 anos acompanhando 630 implantes 
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Straumann®, encontrou falhas em todos os tipos de osso (tipos 1-4), mas com 11 das 17 

perdas localizados em osso dos tipos 3 ou 4. Ao avaliar o prontuário de 700 pacientes que 

colocaram implantes Brånemark®, Alsaadi e colaboradores (2008) detectaram que o osso tipo 

4 esta associado à maior perda tardia de implantes. 

 Desta forma, fica latente a importância de prever a qualidade óssea anteriormente 

à cirurgia de colocação de implante para um melhor planejamento e cuidados necessários ao 

se tratar com osso de baixa qualidade, no intuito de prevenir problemas de falha de 

osseointegração. Nestes casos, pode-se melhorar a estabilidade primária através da sub-

fresagem das porções apicais nas osteotomias, maximizando o comprimento e diâmetro do 

implante em relação à área de contato ósseo, alcançar ancoragem bicortical sem invadir 

estruturas vitais (Ganeles et al., 2008) e utilizar implantes com tratamento de superfície como, 

por exemplo, os de superfície hidrofílica (SLActive®), que proporciona maior bioatividade 

acelerando o contato osso/implante e a maturação óssea (Buser et al., 2004; Bornstein et al., 

2008; Ganeles et al., 2008). Portanto, a verificação da qualidade óssea do local de colocação 

de um implante antes da cirurgia poderia ser realizada a partir de exames de imagens como as 

tomografias que são amplamente utilizadas no planejamento destes procedimentos. 

 Nas tomografias computadorizadas convencionais (CT), é possível a utlilização 

das Unidades Hounsfield (HU) para se determinar a densidade óssea, a qual é validada para 

tal propósito (Turkyilmaz, et al., 2007; Oliveira et al., 2008; Turkyilmaz et al., 2008 (a); Fuh 

et al., 2010; Arisan et al., 2012; Isoda et al., 2012; Valiyaparambil et al., 2012). Misch (1990) 

propôs uma classificação de qualidade óssea a qual atribuiu intervalos de HU, onde o tecido 

ósseo mais denso, chamado de D1, estava na faixa acima de 1250 HU, D2 a valores de 850 a 

1250 HU, D3 a valores de 350 a 850 HU, D4, que é o osso de menor qualidade, a valores de 

150 a 350 HU e D5, que é osso em fase de maturação, a valores menores que 150 HU. Por sua 

vez, Oliveira e colaboradores (2008) encontraram os seguintes valores para a classificação 

óssea de Lekholm e Zarb (1985): osso tipo 1 maior que 400 HU, osso tipo 2 e 3 entre 200 HU 

a 400 HU e osso tipo 4 menor que 200 HU.  

 Entretanto, o cálculo matemático e, consequentemente, as HU não são 

apropriados para avaliação da densidade óssea em tomografias computadorizadas cone beam 

(CBCT). Isto ocorre pois o método físico de obtenção de imagem a partir de um único feixe 

cônico e um único sensor geram o endurecimento do feixe de raio-X, aumento de ruído na 

reconstrução das imagens e provocam o efeito de salto, os quais implicam alterações e 

heterogeneidade das HU de uma imagem (Hua et al., 2009; Nackaerts et al., 2011), 

inviabilizando sua utilização para avaliação de densidade óssea em CBCT. Nackaerts e 
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colaboradores (2011), com a utilização de um padrão pré-definido e conhecido, compararam 

CT e CBCT em relação à análise de variabilidade dos valores de intensidade das imagens e 

demonstraram que na CT a variabilidade é de 0,1% e na CBCT é de 10%, ou seja, 100 vezes 

mais variabilidade na CBCT. 

 Em contrapartida desta limitação de utilização da Unidade Hounsfield (HU) em 

tomografias computadorizadas cone beam, este trabalho utilizou a variação nos tons de cinza 

para avaliação da densidade óptica, uma vez que, assim como a HU em CT, ela também está 

está diretamente ligada à atenuação e absorção dos raios-X em relação à densidade e 

espessura do objeto exposto, no caso o osso. Nos trabalhos de Parsa e colaboradores foi 

demonstrado que os valores de tons de cinza dos voxels na CBCT se afastam das HU em CT, 

quando analisadas as mesmas áreas ósseas nos dois tipos de tomógrafos. Mesmo assim, há 

uma forte correlação entre a variação dos tons de cinza em CBCT e a variação das HU em CT 

(Parsa et al., 2012; Parsa et al., 2013). Da mesma forma, outros autores também encontraram 

correlação entre a variação dos tons de cinza em CBCT e a variação de HU em CT (Reeves et 

al., 2012; Valiyaparambil et al., 2012; Cassetta et al., 2013). Mais trabalhos também 

utilizaram a variação dos tons de cinza para verificação da qualidade óssea em tomografias 

computadorizadas cone beam (Nackaerts et al., 2011; Arisan et al., 2012, Pauwels et al., 

2013). Do mesmo modo como neste trabalho, Pauwels e colaboradores (2013) também 

utilizaram a variação dos tons de cinza de diversos aparelhos e protocolos de obtenção de 

tomografias computadorizadas cone beam e tomografias computadorizadas convencionais, 

onde encontraram correlação de Pearson entre 0,7014 e 0,9996 numa faixa de alta densidade e 

entre 0,5620 e 0,9991 na faixa de média densidade. O erro médio dos valores de voxel de 

CBCT na faixa de média densidade foi de 35 a 1562 unidades. Segundo estes autores, apesar 

de a maioria dos dispositivos de CBCT mostrarem uma boa correlação geral com os números 

das CT, erros podem ser vistos ao utilizar os valores de cinza de uma forma quantitativa, 

como encontrado em três das 30 combinações de métodos e aparelhos avaliados. Embora 

possa ser possível obter unidades “pseudo-Hounsfield” de certas CBCTs, os métodos 

alternativos de avaliação do tecido ósseo devem ser mais investigados ainda. 

 Neste trabalho, houve diferença estatística entre a média dos tons de cinza 

(densidade óptica) entre o osso tipo 3, de 118,76 (+/- 28,90) e o osso tipo 4, de 90,22 (+/- 

24,40). Inesperadamente, o osso tipo 1-2 teve média de tons de cinza de 101,28 (+/- 23,60), 

que foi menor que a média do osso tipo 3, não havendo diferença estatística entre as médias 

do osso tipo 1-2 com o osso tipo 3 e o tipo 4. Uma possível explicação para este achado pode 

estar no fato de que a classificação tátil da qualidade óssea foi primeiramente determinada 
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pela percepção da espessura do osso cortical, onde uma cortical mais espessa, com 2 a 3 mm 

ou até mais, já enquadrava o osso no tipo 1 ou 2, mesmo que o osso medular não fosse tão 

denso. Isto é importante porque a ROI para determinar a média dos tons de cinza tinha altura 

de 6mm, assim como a própria perfuração cirúrgica. Deste modo, a presença de um osso 

medular menos denso em alguns dos locais classificados como osso tipo 1-2 pode ter 

diminuído a média deste grupo. Já no caso de osso tipo 3 e tipo 4, a cortical óssea fina é 

similar para ambas classificações, ocasionando um efeito maior da densidade do osso medular 

tanto na classificação cirúrgica quanto na média dos tons de cinza.  

 Outra forma de avaliar a qualidade óssea através de exames de imagem é com a 

inspeção visual para estabelecer uma classificação, como foi proposto por Lekholm e Zarb 

(1985) para radiografias panorâmicas. Este trabalho realizou a avaliação visual e a 

classificação proposta por estes autores, mas em imagens de tomografias computadorizadas. 

A observação foi realizada por um especialista em imageologia odontológica experiente 

(examinador). Houve uma correlação moderada entre a qualidade óssea cirúrgica e a 

qualidade óssea visual. Em relação às médias de nível de cinza (densidade óptica) em 

comparação com a classificação óssea visual, apesar de não haver diferença estatística entre 

as médias dos níveis de classificação, os resultados foram completamente inesperados, onde o 

osso tipo 3 teve média de tons de cinza de 96,81 (+/- 29,98), inferior ao osso tipo 4 que teve 

média de 106,21 (+/- 19,81). No osso tipo 1-2 a média foi de 124,86 (+/- 33,68). A provável 

explicação para estes resultados está no fato de que o olho humano tem dificuldade em 

determinar e diferenciar o osso medular em relação à sua estrutura e densidade, o que é 

inerente à subjetividade de uma avaliação visual. 

 Na literatura há muitos métodos de avaliação da densidade óssea. Entre eles, as 

medidas histológicas e morfométricas que são o padrão ouro para a medida da densidade 

óssea. Essas medições incluem avaliação quantitativa de tomografia computadorizada, 

absorciometria de dupla energia de raios-X e ressonância magnética, no entanto, estes 

métodos estão limitados na medida em que eles não podem ser aplicados para todos os 

implantes clinicamente (Aparicio et al., 2006; Nackaerts et al., 2011; Oh e Kim, 2012). Este 

trabalho utilizou como critério de avaliação da qualidade óssea a classificação de Lekholm e 

Zarb (1985), através da sensibilidade tátil do cirurgião durante o ato cirúrgico de fresagem 

óssea para colocação do implante, servindo como referência de comparação para os outros 

métodos de avaliação do osso e da estabilidade dos implantes. Apesar desta classificação ser 

amplamente utilizada em pesquisas e clinicamente, pois é fácil de usar e não envolve um 

grande investimento em exames e aparelhos, o método ainda não foi validado (Ribeiro-Rotta 
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et al., 2010). No entanto, tem sido consagrado pelo uso, visto que clinicamente se mostra 

eficaz para determinar o osso tipo 4, de menor qualidade, em relação aos demais tipos ósseos 

da classificação.  

 A presença de osso tipo 4 implica maiores cuidados e certo risco do prognóstico 

do tratamento com implantes, visto que, como no caso do presente estudo, os implantes 

colocados neste tipo ósseo apresentaram menor estabilidade primária, independentemente do 

método de avaliação de estabilidade utilizado. Oh e Kim (2012) utilizaram Periotest e Osstell 

para avaliar a estabilidade primária de 211 implantes em relação à qualidade óssea 

classificada segundo Lekholm e Zarb (1985) e também encontraram menor estabilidade 

inicial dos implantes colocados em osso tipo 4 em comparação com aqueles colocados nos 

tipos 1, 2 e 3.  

 Com relação à estabilidade primária, este estudo demonstrou que o torque de 

inserção maiores que 35Ncm estão localmente associados ao osso tipo 1-2 enquanto que o 

torque de inserção menor que 15Ncm está associado ao osso tipo 4. Este achado corrobora os 

dados demonstrados do estudo em cadáver de Akça e colaboradores (2006), onde os valores 

de torque de inserção dos implantes Straumann® SLA RN de 4,1 x 10mm e Astra Tech de 4 x 

9 mm foram maiores em regiões onde a proporção de volume de osso em relação ao volume 

total do osso era maior, medida em cortes de microtomografia. Também está de acordo com 

os achados de Alsaadi e colaboradores (2007), onde foram avaliados implantes 719 implantes 

Mark III TiUnite® (Brånemark system) e o torque de inserção foi estatisticamente menor em 

osso tipo 4.  

 Do total dos implantes cuja estabilidade inicial foi medida com torque de inserção 

neste trabalho, 38,6% ficaram abaixo de 15Ncm, 34,1% ficaram entre 15 e 35Ncm e 27,3% 

ficaram acima de 35Ncm. Outro estudo que categorizou o torque de inserção de forma 

parecida encontrou 29% abaixo de 15Ncm, 23% entre 15 e 30Ncm e 49% acima de 30Ncm 

(Walker et al., 2011). Esta diferença de cerca de 22 pontos percentuais entre os grupos de 

implantes com maior torque de inserção nos dois estudos pode ter ocorrido devido ao fato de 

que no presente estudo o grupo de torque de inserção mais elevado teve o ponto de corte 

5Ncm mais alto que no estudo prévio, diminuindo o universo de abrangência da categoria de 

maior estabilidade no presente estudo em ralação à mesma categoria do estudo prévio. 

 Quanto à avaliação da estabilidade primária pela análise de capacidade de 

amortecimento medida em valor de Periotest® (PTV), a mediana e intervalo interquartil em 

PTV foram -5,5 (-6,3; -1,5) para osso tipo 1-2, -3,0 (-3,5; 1,5) para osso tipo 3 e 2,5 (0,8; 5,3) 

para o osso tipo 4, sendo que os três grupos foram estatisticamente diferentes entre si, uma 
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relação entre a influência da qualidade óssea e PTV também foi encontrada em outros estudos 

(Alsaadi et al., 2007; Oh e Kim, 2012). Apesar disto, a diferença entre o grupo de osso tipo 1-

2 e o grupo de osso tipo 3 encontrada no presente estudo não é clinicamente relevante uma 

vez que seus respectivos PTVs estão dentro de uma mesma faixa cuja estabilidade é 

considerada adequada para obtenção e manutenção da osseointegração. Isto pode ser inferido 

pelo estudo de Deporter e colaboradores (2002) que avaliaram a estabilidade de 151 implantes 

curtos e encontraram PTV médio de -0,15 de estabilidade primária destes implantes, 

alcançando taxa de sobrevivência de 97,2% após acompanhamento médio de 34,6 meses de 

função dos implantes. Desta forma, apenas o grupo de osso tipo 4 apresentou estabilidade 

menor que seria estatística e clinicamente relevante, indicando algum risco potencial de falhas 

ou intercorrências. Este dado é importante visto que o estudo retrospectivo de Alsaadi e 

colaboradores (2008) relatou que implantes com PTV mais alto, medidos na estabilidade 

primária e secundária, apresentam maior perda tardia de osseointegração, assim como o osso 

tipo 4 está associado ao rico maior de perda tardia de osseointegração. 

 Analisando-se a estabilidade primária dos implantes através das médias de ISQ 

medidas com o Osstell em relação ao tipo ósseo (Leckholm e Zarb, 1985) foi encontrado 

diferença estatística do osso tipo 4, no qual a estabilidade foi menor em relação às demais 

classificações. As médias e desvio padrão de ISQ dos implantes colocados em osso tipo 1-2, 3 

e 4 foram 71,06 (+/- 8,48), 70,24 (+/- 4,24) e 60,54 (+/- 8,38), respectivamente. Por outro 

lado, as médias de ISQ não tiveram diferença estatística quando comparadas em relação à 

qualidade óssea visual da tomografia. Isto reflete, mais uma vez, a dificuldade de realizar-se 

uma classificação da qualidade óssea visualmente devido a limitação do olho humano em 

diferenciar o trabeculado ósseo e sua densidade.  

 O ISQ médio de todos os implantes foi de 67,35 (+/- 8,05), variando de 41,5 a 

79,5. Esta média é próxima ao do trabalho de Rossi e colaboradores (2010) que colocaram, 

em região posterior, 40 implantes SLActive Straumann®, sendo 19 de 4,1 x 6mm e 21 de 4,8 

x 6mm, e encontraram ISQ médio de 70,4 (+/-9,0), variando de 42 a 84. Valores 

relativamente maiores às médias de ISQ encontradas neste estudo também foram encontrados 

em outros estudos que utilizaram implantes com tamanho convencionais, como num onde a 

estabilidade primária de implantes SLActive RN teve ISQ médio de 75,7 (+/- 5,3), variando 

de 65.3 a 81.3 (Han et al., 2010). Noutro foi de 73,5 (+/- 10,2) (Degidi et al., 2010). Já 

Bornstein e colaboradores (2009) relataram ISQ médio de 74,33 (+/- 7,06), variando de 57 a 

87. 
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 Assim como no presente estudo, outros trabalhos também utilizaram a média de 

medições de ISQ em mais de um sentido para representar a estabilidade do implante (Han et 

al., 2010; Merheb et al., 2010 (b)). Já outros autores utilizaram apenas um sentido da sonda 

para determinar a estabilidade do implante (Rodrigo et al., 2010; Herrero-Climent et al., 

2012). Não obstante, Sim e Lang (2010) não encontraram diferenças estatísticas entre a 

posição da sonda no sentido vestibulo-lingual/palatino com o sentido mésio-distal para a 

medição do ISQ. Portanto, o sentido da sonda parece não ter grande efeito na medição do 

ISQ. 

 Os resultados deste trabalho mostraram correlações moderadas significativas entre 

os três métodos de avaliação da estabilidade dos implantes. Entre o torque de inserção e o ISQ 

a correlação foi de 0,606, entre torque de inserção e PTV foi de -0,686 e entre ISQ e PTV foi 

de -0,627. Pode-se verificar também que implantes com torque de inserção menor que 15 

Ncm tiveram ISQ médio menor que os outros dois grupos. Da mesma forma que a média de 

ISQ dos implantes com PTV de -8 a 0 foi significantemente maior que a média dos implantes 

com PTV de 1 e 9. No mesmo sentido, PTV de -8 a 0 está associado ao torque de inserção 

maior que 35Ncm, assim como o PTV de 1 a 9 está associado ao torque de inserção menor 

que 15 Ncm. 

 Não obstante, Merheb e Colaboradores, (2010 a) também encontraram correlação 

significativa entre ISQ e PTV de -0,520. A correlação entre o ISQ e PTV foi 0,777 em outro 

estudo, o que foi estatisticamente significativo (Oh e Kim, 2012). Por sua vez, Zix e 

colaboradores (2008) encontraram correlações entre o método de medição da estabilidade de 

implantes com Periotest® e com Osstell® de -0,640 (Pearson) e -0,650 (Spearman). Os 

coeficientes de correlação intraclasse para os valores do ISQ e PTV foram de 0,990 e 0,880, 

respectivamente (IC 95%). Herrero-Climent e colaboradores (2012) também relataram 

coeficiente de correlação intraclasse de 0.960 para o Osstell. Estudos laboratoriais utilizando 

o aparelho Osstell® e o Periotest® demonstraram um elevado coeficiente de correlação entre 

os dois métodos de -0.900 e -0.800 (Lachmann et al., 2006a; Lachmann et al., 2006b). Essa 

correlação mais forte entre PTV e ISQ encontrada em trabalhos laboratoriais pode ser 

explicada pelo fato de que, em uso clínico, a medição de estabilidade é limitada pelo acesso, 

espaço e colaboração do paciente, ao contrário de um experimento de laboratório onde estes 

vieses são controlados. O Periotest é mais suscetível a variáveis clínicas de medição do que o 

dispositivo Osstell. Desta forma, no caso do Periotest, outras variáveis podem alterar o valor 

medido. Estes fatores, como a angulação da peça de mão, o ponto de medição vertical no pilar 

do implante, e a distância horizontal da peça de mão do implante, podem ser bem controlados 
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em estudos in vitro, padronizando a medição, mas é mais difícil em ensaios in vivo (Zix et al., 

2008). 

 Em uma meta-análise foi demonstrada correlação entre torque de corte/torque de 

inserção e RFA (Cehreli et al., 2009). No estudo de Walker e colaboradores (2006) correlação 

significativa entre a ITV e ISQ foi de 0,790. Em outra pesquisa, a média do torque de inserção 

dos implantes com ISQ maior ou igual a 60 foi significantemente maior que a média de torque 

de inserção para os implantes com ISQ menor que 60 (Alsaadi et al., 2007). Em contrapartida, 

Degidi e colaboradores (2010) encontraram uma correlação fraca, de 0,247, entre o torque de 

inserção e os valores de ISQ. Estes autores atribuíram este resultado ao fato que a análise de 

frequência de ressonância e o torque de inserção representam duas características diferentes 

de estabilidade primária, com a primeira indicando a resistência à carga de flexão e o segundo 

indica a resistência às forças de cisalhamento. 

 Do ponto de vista do clínico, o método de avaliação mais acessível ao clínico é o 

torque de inserção, cuja medida pode ser obtida com equipamentos relativamente simples e 

baratos como o torquímetro manual ou o motor e contra-ângulo utilizado para colocação de 

implantes. Isto porque ambos fazem parte do material básico de implantodontia, 

diferentemente do Periotest® e do Osstell®. Entretanto, este é um método que avalia apenas a 

estabilidade primária e não serve para o monitoramento da estabilidade dos implantes e, 

consequentemente, a osseointegração ao longo do tempo. 

 Para monitorar a estabilidade e a osseointegração dos implantes, tanto o 

Periotest® quanto o Osstell® podem ser utilizados. Cranin e colaboradores (1998) 

encontraram correlação entre PTV e a perda óssea avaliada radiograficamente. Chan e 

colaboradores (2010), em um estudo em cadáver, demonstraram correlação entre medições de 

RFA e perda óssea circunferencial. Os valores de ponto de corte para determinar a perda da 

osseointegração não estão estabelecidos nem para ISQ quanto para PTV. No entanto, alguns 

autores sugerem valores que corresponderia a implantes osseointegrados. Por exemplo, 

Rodrigo e colaboradores (2010) não relataram perdas de implantes com ISQ acima de 60, 

enquanto que o risco de perda dos implantes abaixo de 60 foi de 19%. Outro estudo indicou 

que implantes clinicamente estáveis são encontrados com valores de ISQ de 40 a 80 (Aparicio 

et al., 2006). Segundo o fabricante do Periotest®, valores de PTV entre -8 e 0 são 

considerados adequados para osseointegração (Periotest Procedure). Já para Olivé e Aparicio 

(1990), esta faixa de estabilidade, que corresponde à níveis adequados para obtenção e 

manutenção da osseointegração, varia de -5 a 5. Em outro estudo, foi sugerido que implantes 

com estabilidade inicial acima de -2 PTV possuíam risco aumentado para falha inicial, sendo 
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que este ponto de corte possuía sensibilidade de 84% e especificidade de 39% (Noguerol et 

al., 2006). Deste modo, mais importante que o valor do ISQ ou do PTV em si é a variação 

destes valores ao longo do tempo em cada implante, onde a diminuição do ISQ e o aumento 

do PTV podem sugerir que o implante esteja em risco de perder a osseointegração. 

 O Periotest® é mais amigável e mais eficiente em termos de custos e tempo 

gastos porque as próteses não esplintadas não precisam ser removidas, assim como o aparelho 

do Periotest não possui limitação de quantidade de vezes a ser utilizado. Por outro lado, a 

utilização do Osstell® é limitado uma vez que as próteses devem ser removidas para a 

medição, os transdutores são descartáveis e também não estão disponíveis para todos os 

sistemas de implantes (Zix et al., 2008). Contudo, o Periotest® está sujeito a variáveis que 

podem alterar os valores de medição, tais como a angulação do dispositivo manual, o ponto 

vertical de medição no pilar intermediário do implante, e a distância horizontal do dispositivo 

manual para o intermediário do implante (Meredith et al., 1998). Isto não ocorre com o 

Osstell, que é menos suscetível ao manejo do operador. 

 No presente estudo, ocorreu uma complicação durante este estudo, no momento 

da cirurgia, onde um implante colocado na região do dente 37 ficou instável, com 

movimentos laterais e foi decidido removê-lo neste momento. Não foi considerada como 

perda de implante pois não houve falha de cicatrização óssea, mas sim uma dificuldade 

técnica da colocação de implante curto que impossibilitou a sua instalação. Ambos não 

entraram na análise estatística.  

Analisando o fato ocorrido, acredita-se que a falta de estabilidade mínima para 

manutenção do implante em questão ocorreu por dificuldade técnica do reduzido espaço 

oclusal na região. Devido a este aspecto, o contra-ângulo tocava no dente antagonista, 

inclinando a broca no início da fresagem. A medida que a broca penetrava no osso, foi 

realizado algum movimento de pêndulo no sentido vestíbulo-lingual para a correção do eixo 

de inserção do implante, gerando o alargamento excessivo do sítio para colocação do 

implante. Este problema parece maior em implantes curtos porque a fresagem é menor em 

relação aos implantes mais longos, onde movimentos pendulares no início da fresagem são 

mais facilmente compensados pelo paralelismo e tamanho correto da porção final da 

fresagem. Na região dos segundos molares superiores o movimento de pêndulo também pode 

ocorrer no sentido mésio-distal pela dificuldade de posicionamento do contra-ângulo, e a 

inclinação da broca para mesial facilita o acesso e a visualização, mas deve ser evitada. Para 

não se repetir o problema da primeira cirurgia, foi solicitado para o paciente abrir a boca e 
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fazer um movimento lateral da mandíbula durante a fresagem, o que evitou o pêndulo do 

contra-ângulo e possibilitou a colocação do novo implante com estabilidade adequada. 

 Com relação ao conceito de implante curto, não há consenso nos trabalhos 

encontrados na literatura. O ponto de corte da medida da altura do implante para a inclusão 

como implante curto tem variado em igual e/ou abaixo de 11 mm, 10 mm, 9 mm, 8 mm e 7 

mm (Bahat, 1993; Brocard et al., 2000; Feldman et al., 2004; Arlin, 2006; Cannizzaro et al., 

2008; Deporter et al., 2008; Corrente et al., 2009; De Santis et al., 2011). Apesar da falta de 

consenso, implantes menores que 7 mm seriam classificados como curtos pela maioria dos 

autores, o que abrange o tamanho de implantes utilizados neste estudo. 

 Como limitações deste estudo, podemos apontar dois fatores principais. O 

primeiro é o tamanho da amostra reduzido, o que inviabilizou a análise da correlação entre os 

métodos de avaliação da estabilidade dos implantes dentro dos subgrupos de tipos de osso de 

acordo com a sua qualidade avaliada cirurgicamente. Isto ocorreu devido à dificuldade de 

encontrar pacientes elegíveis para este trabalho, devido aos rigorosos critérios de inclusão e 

exclusão e pelo fato de que apenas pacientes que potencialmente teriam a indicação de 

implantes curtos unitários posteriores foram realmente triados. Isto representaria uma primeira 

seleção da amostra de conveniência, a qual não foi medida em termos da quantidade de 

pacientes, o que foi possível apenas na triagem específica realizada. 

 O segundo fator diz respeito à variabilidade nos exames tomográficos. Isto 

ocorreu porque foram utilizadas imagens previamente adquiridas pelos pacientes em diversos 

serviços de diagnóstico por imagem, uma vez que muitos dos pacientes que procuraram o 

serviço já tinham sido avaliados por outros colegas e possuíam os exames de imagem com 

menos de seis meses. Desta forma, não foi possível obter um padrão no protocolo de 

aquisição nas imagens de avaliação pré-cirúrgica (iniciais). Esta escolha está embasada no 

principio de justificação e limitação de dose em radioproteção, ao qual não seria justificável 

solicitar repetição de exame em radiação ionizante visto que o paciente já o havia realizado 

para outros fins. 

 Por outro lado, este trabalho é relevante visto que na literatura encontram-se 

muitos dados sobre a estabilidade de implantes com tamanhos convencionais, contudo há 

pouca informação a respeito da estabilidade de implantes curtos. Também é importante 

destacar que este trabalho foi realizado em ambiente privado, e que são poucos os trabalhos 

que avaliam pacientes fora do meio hospitalar ou de faculdades (Nedir et al., 2004; Rodrigo et 

al., 2010), contudo, nenhum trabalho havia avaliado a estabilidade inicial de implantes 

SLActive Straumann® de 4,1 x 6 mm através do torque de inserção, Periotest® e Osstell® e 
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do efeito da qualidade óssea sobre este desfecho. Sem dúvidas, o terceiro fator de relevância é 

a tentativa de estabelecer um método de avaliação da qualidade óssea através da análise de 

imagens, previamente à colocação dos implante, com o intuito de prevenir intercorrência e 

falhas do tratamento com implantes, uma vez que o uso de CBCT vem aumentando e as HU 

são úteis apenas para CT.  

Como é importante o acompanhamento a longo prazo para estabelecer a 

previsibilidade de um tratamento, os pacientes desta pesquisa serão acompanhados para 

obtenção destes dados. Também pode-se sugerir que outros estudos venham a avaliar outras 

formas de medir a qualidade óssea das imagens de cbct com a variação dos tons de cinza, que 

mostra-se um método promissor, mas com necessidade de avanços para este fim. Muitos 

trabalhos nesta área estão sendo realizados, mas ainda não há um método validado 

equivalente a hu em ct para a avaliação da densidade óssea em CBCT. 
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6  CONCLUSÕES 

 Considerando-se as características e limitações deste estudo, os resultados 

sugerem que o tipo de osso tem efeito significativo na estabilidade primária medida através de 

torque manual, análise de frequência de ressonância (ISQ) e capacidade de amortecimento 

(PTV). Os implantes instalados em osso tipo 4 mostraram estabilidade primária 

significativamente menor do que os implantes instalados em osso tipo 1-2 e 3. 

Houve uma correlação moderada entre os três métodos de medição de estabilidade 

primária (torque de inserção, análise de frequência de ressonância e capacidade de 

amortecimento), sugerindo que outros fatores devem influenciar a medição em cada método 

específico. 

Além disso, os resultados encontraram correlação moderada entre a avaliação 

visual da qualidade óssea em imagens de Tomografia Computadorizada de acordo com a 

classificação de Lekholm e Zarb (1985), com a avaliação subjetiva da qualidade óssea durante 

a cirurgia. Por outro lado, a densidade óptica não teve correlação com a avaliação da 

qualidade óssea cirúrgica nem com a qualidade óssea visual, nem com a estabilidade primária 

dos implantes curtos. Entretanto, os procedimentos utilizados para avaliação da densidade 

óptica de imagens de CBCT podem auxiliar no desenvolvimento de um possível novo método 

de avaliação de qualidade óssea pré-cirúrgica. 

Foi tambem alcançado o objetivo de estabelecer uma amostra de pacientes com 

implantes curtos para estudo de coorte. 



81 

 

REFERÊNCIAS  

Akça K, Chang TL, Tekdemir I, Fanuscu MI. Biomechanical aspects of initial intraosseous 

stability and implant design: a quantitative micro-morphometric analysis. Clin Oral Implants 

Res. 2006 Aug;17(4):465-72. 

 

Al-Nawas B, Wagner W, Grötz KA. Insertion torque and resonance frequency analysis of 

dental implant systems in an animal model with loaded implants. Int J Oral Maxillofac 

Implants. 2006 Sep-Oct;21(5):726-32. 

 

Alsaadi G, Quirynen M, Komàrek A, van Steenberghe D. Impact of local and systemic factors 

on the incidence of late oral implant loss. Clin Oral Implants Res. 2008 Jul;19(7):670-6. 

 

Alsaadi G, Quirynen M, Michiels K, Jacobs R, van Steenberghe D. A biomechanical 

assessment of the relation between the oral implant stability at insertion and subjective bone 

quality assessment. J Clin Periodontol. 2007 Apr;34(4):359-66. 

 

Angelopoulos C, Scarfe WC, Farman AG. A comparison of maxillofacial CBCT and medical 

CT. Atlas Oral Maxillofac Surg Clin North Am. 2012 Mar;20(1):1-17. 

 

Aparicio C, Lang N P, Rangert B. Validity and clinical significance of biomechanical testing 

of implant/bone interface. Clin Oral Implants Res. 2006 Oct;17 Suppl 2:2-7. 

 

Arisan V, Karabuda ZC, Avsever H, Ozdemir T. conventional multi-slice computed 

tomography (CT) and cone-beam ct (CBCT) for computer-assisted implant placement. part i: 

relationship of radiographic gray density and implant stability. Clin Implant Dent Relat Res. 

2012 Jan 17. doi: 10.1111/j.1708-8208.2011.00436.x. [Epub ahead of print]. 

 

Arlin, M. L. Short dental implants as a treatment option: results from an observational study 

in a single private practice. Int J Oral Maxillofac Implants. 2006 Sep-Oct;21(5):769-76. 

 

Atsumi M, Park SH, Wang HL. Methods used to assess implant stability: current status. Int J 

Oral Maxillofac Implants. 2007 Sep-Oct;22(5):743-54. 

 

Baelum V, Ellengaard, B. Implant survival in periodontally compromised patients. J 

Periodontol. 2004 Oct;75(10):1404-12. 

 

Bahat O. Treatment planning and placement of implants in the posterior maxillae: report of 

732 consecutive Nobelpharma implants. Int J Oral Maxillofac Implants. 1993;8(2):151-61. 

 

Barewal RM, Oates TW, Meredith N, Cochran DL. Resonance frequency measurement of 

implant stability in vivo on implants with a sandblasted and acid-etched surface. Int J Oral 

Maxillofac Implants. 2003 Sep-Oct;18(5):641-51. 

 

Bell RB, Blakey GH, White RP, Hillebrand DG, Molina A. Staged reconstruction of the 

severely atrophic mandible with autogenous bone graft and endosteal implants. J Oral  

Maxillofac Surg. 2002 Oct;60(10):1135-41. 

                                                           

 
 Sistema de Citação autor data e formato de referências conforme Vancouver.  



82 

 

 

Benavides E, Rios HF, Ganz SD, An CH, Resnik R, Reardon GT, et al. Use of cone beam 

computed tomography in implant dentistry: The International Congress of Oral 

Implantologists Consensus Report. Implant Dent. 2012 Apr;21(2):78-86. 

 

Bergkvist G, Simonsson K, Rydberg K, Johansson F, Dérand T. A finite element analysis of 

stress distribution in bone tissue surrounding uncoupled or splinted dental implants. Clin 

Implant Dent Relat Res. 2008 Mar;10(1):40-6. 

 

Blanes RJ, Bernard JP, Blanes ZM, Belser UC. A 10-year prospective study of ITI dental 

implants placed in the posterior region I: clinical and radiographic results. Clin Oral Implants 

Res. 2007 Dec;18(6):699-706. 

 

Block MS, Gardiner D, Kent JN, Misiek DJ, Finger IM, Guerra L. Hydroxyapatite-coated 

cylindrical implants in the posterior mandible: 10-year observations. Int J Oral Maxillofac 

Implants. 1996 Sep-Oct;11(5):626-33. 

 

Bornstein MM, Hart CN, Halbritter SA, Morton D, Buser D. Early loading of nonsubmerged 

titanium implants with a chemically modified sand-blasted and acid-etched surface: 6-month 

results of a prospective case series study in the posterior mandible focusing on peri-implant 

crestal bone changes and implant stability quotient (ISQ) values. Clin Implant Dent Relat Res. 

2009 Dec;11(4):338-47. 

 

Bornstein MM, Valderrama P, Jones AA, Wilson TG, Seibl R, Cochran DL. Bone apposition 

around two different sandblasted and acid-etched titanium implant surfaces: a 

histomorphometric study in canine mandibles. Clin Oral Implants Res. 2008 Mar;19(3):233-

41. 

 

Brocard D, Barthet P, Baysse E, Duffort JF, Eller P, Justumus P, et al. A multicenter report on 

1,022 consecutively placed ITI implants: a 7-year longitudinal study. Int J Oral Maxillofac 

Implants. 2000 Sep-Oct;15(5):691-700. 

 

Buser D, Brägger U, Lang NP, Nyman S. Regeneration and enlargement of jaw bone using 

guided tissue regeneration. Clin Oral Implants Res. 1990 Dec;1(1):22-32. 

 

Buser D, Broggini N, Wieland M, Schenk RK, Denzer AJ, Cochran DL, et al. Enhanced bone 

apposition to a chemically modified SLA titanium surface J Dent Res. 2004 Jul;83(7):529-33. 

 

Buser D, Dula K, Belser U, Hirt HP, Berthold H. Localized ridge augmentation using guided 

bone regeneration. 1. Surgical procedure in the maxilla. Int J Periodontics Restorative Dent. 

1993;13(1):29-45. 

 

Buser D, Mericske-Stern R, Bernard JP, Behneke A, Behneke N, Hirt HP, et al. Long-term 

evaluation of non-submerged iti implants. part1: 8 years life table analyses of a prospective 

multi-center study with 2359 implants. Clin Oral Implants Res. 1997 Jun;8(3):161-72. 

 

Cannizzaro G, Leone M, Torchio C, Viola P, Esposito, M. Immediate versus early loading of 

7-mm-long flapless-placed single implants: a split-mouth randomised controlled clinical trial. 

Eur J Oral Implantol. 2008 Winter;1(4):277-92. 



83 

 

Cassetta M, Stefanelli LV, Pacifici A, Pacifici L, Barbato E. How accurate is cbct in 

measuring bone density? A comparative cbct-ct in vitro study. Clin Implant Dent Relat Res. 

2013 Jan 7. doi: 10.1111/cid.12027. [Epub ahead of print]. 

 

Cehreli MC, Karasoy D, Akca K, Eckert SE. Meta –analysis of methods used to assess 

implant stability. Int J Oral Maxillofac Implants. 2009 Nov-Dec;24(6):1015-32. 

 

Chan HL, El-Kholy K, Fu JH, Galindo-Moreno P, Wang HL. I Implant primary stability 

determined by resonance frequency analysis in surgically created defects: a pilot cadaver 

study. mplant Dent. 2010 Dec;19(6):509-19. 

 

Cooper, LF. Factors influencing primary dental implant stability remain unclear. J Evid Based 

Dent Pract. 2010 Mar;10(1):44-5. 

 

Cormack AM. Early two-dimensional reconstruction (CT scanning) and recent topics 

stemming from it. Nobel lecture, December 8, 1979. J Comput Assist Tomogr. 1980 

Oct;4(5):658-64. 

 

Corrente G, Abundo R, Ambrois AB, Savio L, Perelli, M. Short porous implants in the 

posterior maxilla: a 3-year report of a prospective study. Int J Periodontics Restorative Dent. 

2009 Feb;29(1):23-9. 

 

Cranin AN, DeGrado J, Kaufman M, Baraoidan M, DiGregorio R, Batgitis G, et al. 

Evaluation of the periotest as a diagnostic tool for dental implants. J Oral Implantol. 

1998;24(3):139-46. 

 

Davarpanah M, Martinez H, Celletti R, Alcoforado G, Tecucianu JF, Etienne D. Osseotite 

implant: 3-year prospective multicenter evaluation. Clin Implant Dent Relat Res. 

2001;3(2):111-8. 

 

De Santis D, CuCchi A, Longhi C, Vincenzo B. Short threaded implants with an oxidized 

surface to restore posterior teeth: 1- to -3 year results of a prospective study. Int J Oral 

Maxillofac Implants. 2011 Mar-Apr;26(2):393-403. 

 

Degidi M, Daprile G, Piattelli A. Determination of primary stability: a comparison of the 

surgeon’s perception and objective measurements. Int J Oral Maxillofac Implants. 2010 May-

Jun;25(3):558-61. 

 

Deporter D, Ogiso B, Sohn D, Ruljancich K, Pharoahi, M. Ultrashort sintered porous-surfaced 

dental implants used to replace posterior teeth. J Periodontol. 2008 Jul;79(7):1280-6. 

 

Deporter D, Todescan R, Riley N. Porous-surfaced dental implants in the partially edentulous 

maxilla: assessment for subclinical mobility. Int J Periodontics Restorative Dent. 2002 

Apr;22(2):184-92. 

 

Esposito M, Cannizarro G, Soardi E, Pellegrino G, Pistilli R, Felice P. A 3-year post-loading 

report of a randomised controlled trial on the rehabilitation of posterior atrophic mandibles: 

short implants or longer implants in vertically augmented bone? Eur J Oral Implantol. 2011 

Winter;4(4):301-11. (a).  

 



84 

 

Esposito M, Cannizzaro G, Soardi E, Pistilli R, Piattelli M, Corvino V, Felice P. Posterior 

atrophic jaws rehabilitated with prostheses supported by 6 mm-long, 4 mm-wide implants or 

by longer implants in augmented bone. Preliminary results from a pilot randomised controlled 

trial. Eur J Oral Implantol. 2012 Spring;5(1):19-33. 

 

Esposito M, Pellegrino G, Pistilli R, Felice P. Rehabilitation of posterior atrophic edentulous 

jaws: prostheses supported by 5 mm short implants or by longer implants in augmented bone? 

One-year results from a pilot randomised clinical trial. Eur J Oral Implantol. 2011 

Spring;4(1):21-30. (b). 

 

Feldman S, Boitel N, Weng D, Kohles SS, Stach RM. Five-year survival distributions of 

short-length (10 mm or less) machined-surfaced and Osseotite implants. Clin Implant Dent 

Relat Res. 2004;6(1):16-23. 

 

Felice P, Pistilli R, Piattelli M, Soardi E, Corvino V, Esposito M. Posterior atrophic jaws 

rehabilitated with prostheses supported by 5 x 5 mm implants with a novel nanostructured 

calcium-incorporated titanium surface or by longer implants in augmented bone. Preliminary 

results from a randomised controlled trial. Eur J Oral Implantol. 2012 Summer;5(2):149-61. 

 

Ferreira T, Rasband W. The mageJ User Guide — IJ 1.45 , imagej.nih.gov/ij/ docs/guide/ . 

2010-2011. 

 

Fuh LJ, Huang HL, Chen CS, Fu KL, Shen YW, Tu MG, et al. Variations in bone density at 

dental implant sites in different regions of the jawbone. J Oral Rehabil. 2010 May 

1;37(5):346-51. 

 

Fuster-Torres MÁ, Peñarrocha-Diago M, Peñarrocha-Oltra D, Peñarrocha-Diago M. 

Relationships between bone density values from cone beam computed tomography, maximum 

insertion torque, and resonance frequency analysis at implant placement: a pilot study. Int J 

Oral Maxillofac Implants. 2011 Sep-Oct;26(5):1051-6. 

 

Ganeles J, Zöllner A, Jackowski J, ten Bruggenkate C, Beagle J, Guerra F. Immediate and 

early loading of Straumann implants with a chemically modified surface (SLActive) in the 

posterior mandible and maxilla: 1-year results from a prospective multicenter study. Clin Oral 

Implants Res. 2008 Nov;19(11):1119-28. 

 

Grant BT, Kraut RA. Dental implants in geriatric patients: a retrospective study of 47 cases. 

Implant Dent. 2007 Dec;16(4):362-8. 

 

Grant BT, Pancko FX, Kraut RA. Outcomes of placing short dental implants in the posterior 

mandible: a retrospective study of 124 cases. J Oral Maxillofac Surg. 2009 Apr;67(4):713-7. 

 

Grunder U, Polizzi G, Goené R, Hatano N, Henry P, Jackson WJ, et al. A 3-year prospective 

multicenter follow-up report on the immediate and delayed-immediate placement of implants. 

Int J Oral Maxillofac Implants. 1999 Mar-Apr;14(2):210-6. 

 

Han J, Lulic M, Lang NP. Factors influencing resonance frequency analysis assessed by 

Osstell mentor during implant tissue integration: II. Implant surface modifications and 

implant diameter. Clin Oral Implants Res. 2010 Jun;21(6):605-11. 



85 

 

Herrero-Climent M, Albertini M, Rios-Santos JV, Lázaro-Calvo P, Fernández-Palacín A, 

Bullon P. Ressonance frequency analysis-reliability in thrid generation instruments: osstell 

mentor. Med Oral Patol Oral Cir Bucal. 2012 Sep 1;17(5):e801-6. 

 

Higuchi KW, Folmer T, Kultje C. Implant survival rates in partially edentulous patients a 3-

year prospective multicenter: study. J Oral Maxillofac Surg. 1995 Mar;53(3):264-8. 

 

Himmlová L, Dostálová T, Kácovský A, Konvicková S. Influence of implant length and 

diameter on stress distribution: a finite element analysis. J Prosthet Dent. 2004 Jan;91(1):20-

5. 

 

Hong J, Lim YJ, Park SO. Quantitative biomechanical analysis of the influence of the cortical 

bone and implant length on primary stability. Clin Oral Implants Res. 2012 Oct;23(10):1193-

7. 

 

Hounsfield GN. Nobel lecture, 8 December 1979. Computed medical imaging. J Radiol. 1980 

Jun-Jul;61(6-7):459-68. 

 

Hsu JT, Huang HL, Tsai MT, Wu AY, Tu MG, Fuh LJ. Effects of the 3D bone-to-implant 

contact and bone stiffness on the initial stability of a dental implant: micro-CT and resonance 

frequency analyses. Int J Oral Maxillofac Surg. 2013 Feb;42(2):276-80. 

 

Hua Y, Nackaerts O, Duyck J, Maes F, Jacobs, R. Bone quality assessment based on cone 

beam computed tomography imaging. Clin Oral Implants Res. 2009Aug;20(8):767-71. 

 

Ilizarov GA. The tension-stress effect on the genesis and growth of tissues: Part II. The 

influence of the rate and frequency of distraction. Clin Orthop Relat Res. 1989 Feb;(239):263. 

 

Isoda K, Ayukawa Y, Tsukiyama Y, Sogo M, Matsushita Y, Koyano K. Relationship between 

the bone density estimated by cone-beam computed tomography and the primary stability of 

dental implants. Clin Oral Implants Res. 2012 Jul;23(7):832-6. 

 

Karl M, Graef F, Heckmann S, Krafft T. Parameters of resonance frequency measurement 

values: a retrospective study of 385 ITI dental implants. Clin Oral Implants Res. 2008 

Feb;19(2):214-8. 

 

Katsumata A, Hirukawa A, Okumura S, Naitoh M, Fujishita M, Ariji E, et al. Relationship 

between density variability and imaging volume size in cone-beam computerized tomographic 

scanning of the maxillofacial region: an in vitro study. Oral Surg Oral Med Oral Pathol Oral 

Radiol Endod. 2009 Mar;107(3):420-5. 

 

Katsumata A, Hirukawa A, Okumura S, Naitoh M, Fujishita M, Ariji E, et al. Effects of 

image artifacts on gray-value density in limited-volume cone-beam computerized 

tomography. Oral Surg Oral Med Oral Pathol Oral Radiol Endod. 2007 Dec;104(6):829-36. 

 

Kaya S, Yavuz I, Uysal I, Akkuş Z. Measuring bone density in healing periapical lesions by 

using cone beam computed tomography: a clinical investigation. J Endod. 2012 Jan;38(1):28-

31. 

 



86 

 

Lachmann S, Jäger B, Axmann D, Gomez-Roman G, Groten M, Weber H. Resonance 

frequency analysis and damping capacity assessment. Part I: an in vitro study on measurement 

reliability and a method of comparison in the determination of primary dental implant 

stability. Clin Oral Implants Res. 2006 Feb;17(1):75-9. (a). 

 

Lachmann S, Laval JY, Jäger B, Axmann D, Gomez-Roman G, Groten M, et al. Resonance 

frequency analysis and damping capacity assessment. Part 2: peri-implant bone loss follow-

up. An in vitro study with the Periotest and Osstell instruments. Clin Oral Implants Res. 2006 

Feb;17(1):80-4. (b). 

 

Lee S, Gantes B, Riggs M, Crigger M. Bone density assessments of dental implant sites: 3. 

Bone quality evaluation during osteotomy and implant placement. Int J Oral Maxillofac 

Implants. 2007 Mar-Apr;22(2):208-12. 

 

Lekholm U, Zarb GA. Patient selection and preparation. In: Branemark PI, Zarb GA, 

Albektsson T (editors). Tissue Integrated Prostheses: osseointegration in clinical dentistry. 

Chicago: Quintessence; 1985:199–209. 

 

Lindh C, Petersson A, Rohlin M. Assessment of the trabecular pattern before endosseous 

implant treatment: Diagnostic outcome of periapical radiography in the mandible. Oral Surg 

Oral Med Oral Pathol Oral Radiol Endod. 1996 Sep;82(3):335-43. 

 

Lioubavina-Hack N, Lang NP, Karring T. Significance of primary stability for 

osseointegration of dental implants. Clin Oral Implants Res. 2006 Jun;17(3):244-50. 

 

Mah P, Reeves TE, McDavid WD. Deriving Hounsfield units using grey levels in cone beam 

computed tomography. Dentomaxillofac Radiol. 2010 Sep;39(6):323-35. 

 

Makary C, Rebaudi A, Mokbel N, Naaman N. Peak insertion torque correlated to 

histologically and clinically evaluated bone density. Implant Dent. 2011 Jun;20(3):182-91. 

 

Maló P, Nobre MA, Lopes A. Short implants in posterior jaws. a prospective 1-year study. 

Eur J Oral Implantol. 2011 Spring;4(1):47-53. 

 

Marquezan M, Osório A, Sant’Anna E, Souza MM, Maia L. Does bone mineral density 

influence the primary stability of dental implants? A systematic review. Clin Oral Implants 

Res. 2012 Jul;23(7):767-74.  

 

Medizintechnick Gulden e.K. Periotest Procedure. Modautal; 2008. [cited 2013 May 28]. 

Available from: http://www.med-

gulden.com/downloads/02_english/01_Productinformation/Periotest_procedure.pdf último 

acesso em 23/05/2013. 

 

Meredith N, Alleyne D, Cawley P. Quantitative determination of the stability of the implant-

tissue interface using resonance frequency analysis. Clin Oral Implants Res. 1996 

Sep;7(3):261-7. 

 

Meredith N, Cawley P, Alleyne. The application of modal vibration analysys in study bone 

healing in-vivo. J. Dent. Res. 1994 Apr;73(4):793. Divisional Abstracts. n.  56. 



87 

 

Meredith N, Friberg B, Sennerby L, Aparicio C. Relationship between contact time 

measurements and PTV values when using the Periotest to measure implant stability. Int J 

Prosthodont. 1998 May-Jun;11(3):269-75. 

 

Merheb J, Coucke W, Jacobs R, Naert I, Quirynen M. Influence of bony defects on implant 

stability. Clin Oral Implants Res. 2010 Sep;21(9):919-23. (b). 

 

Merheb J, Van Assche N, Coucke W, Jacobs R, Naert I, Quirynen M. Relationship between 

cortical bone thickness or computerized tomography-derived boné density values and implant 

stability. Clin Oral Implants Res. 2010 Jun;21(6):612-7 (a). 

 

Misch CE. Density of bone: effect on treatment plans, surgical approach, healing, and 

progressive boen loading. Int J Oral Implantol. 1990;6(2):23-31. 

 

Molly L. Bone density and primary stability in implant therapy. Clin Oral Implants Res. 2006 

Oct;17 Suppl 2:124-35. 

 

Nackaerts O, Maes F, Yan H, Couto Souza P, Pauwels R, Jacobs R. Analysis of intensity 

variability in multislice and cone beam computed tomography. Clin Oral Implants Res. 2011 

Aug;22(8):873-9. 

 

Nedir R, Bischof M, Briaux JM, Beyer S, Szmukler-Moncler S, Bernard JP. A 7-year life 

table analysis from a prospective study on iti implants with special emphasis on the use of 

short implants: results from a private practice. Clin Oral Implants Res. 2004 Apr;15(2):150-7. 

 

Noguerol B, Muñoz R, Mesa F, de Dios Luna J, O'Valle F. Early implant failure. Prognostic 

capacity of periotests: retrospective study of a large sample. Clin Oral Implants Res. 2006 

Aug;17(4):459-64. 

 

Norton MR, Gamble C. Bone classification: An objective scale of bone density using the 

computerized tomography scan. Clin Oral Implants Res. 2001 Feb;12(1):79-84. 

 

Oh JS, Kim SG, Lim SC, Ong JL. A comparative study of two noninvasive techniques to 

evaluate implant stability: periotest and osstell mentor. Oral Surg Oral Med Oral Pathol Oral 

Radiol Endod. 2009 Apr;107(4):513-8. 

 

Oh JS, Kim SG. Clinical study of the relationship between implant stability measurements 

using periotest and osstell mentor and bone quality assessment. Oral Surg Oral Med Oral 

Pathol Oral Radiol. 2012 Mar;113(3):e35-40. 

 

Olivé J, Aparício C. The periotest method as a measure of osseointegrated oral implant 

stability. Int J Oral Maxillofac Implants. 1990 Winter;5(4):390-400. 

 

Oliveira RC, Leles CR, Normanha LM, Lindh C, Ribeiro-Rotta RF. Assessments of 

trabecular bone density at implant sites on CT images. Oral Surg Oral Med Oral Pathol Oral 

Radiol Endod 2008;105:231-8. 

 

Ottoni JM, Oliveira ZF, Mansini R, Cabral AM. Correlation between placement torque and 

survival of single-tooth implants. Int J Oral Maxillofac Implants. 2005 Sep-Oct;20(5):769-76. 



88 

 

Pagliani L, Sennerby L, Petersson A, Verrocchi D, Volpe S, Andersson P. The relationship 

between resonance frequency analysis (RFA) and lateral displacement of dental implants: an 

in vitro study. J Oral Rehabil. 2013 Mar;40(3):221-7. 

 

Parsa A, Ibrahim N, Hassan B, Motroni A, van der Stelt P, Wismeijer D. Influence of cone 

beam CT scanning parameters on grey value measurements at an implant site. 

Dentomaxillofac Radiol. 2013;42(3):79884780, 1-7.  

 

Parsa A, Ibrahim N, Hassan B, Motroni A, van der Stelt P, Wismeijer D. Reliability of Voxel 

Gray Values in Cone Beam Computed Tomography for Preoperative Implant Planning 

Assessment. Int J Oral Maxillofac Implants. 2012 Nov-Dec;27(6):1438-42.  

 

Pauwels R, Nackaerts O, Bellaiche N, Stamatakis H, Tsiklakis K, Walker A, et al. Variability 

of dental cone beam CT grey values for density estimations. Br J Radiol. 2013 

Jan;86(1021):20120135. doi: 10.1259/bjr.20120135. 

 

Perelli M, Abundo R, Corrente G, Saccone, C. Short (5 and 7 mm long) porous implants in 

the posterior atrophic mandible: a 5-year report of a prospective study. Eur J Oral Implantol 

2011;4(4):363–368. 

 

Petrie CS, Williams JL. Comparative evaluation of implant designs: influence of diameter, 

length, and taper on strains in the alveolar crest. A three-dimensional finite-element analysis. 

Clin Oral Implants Res. 2005 Aug;16(4):486-94. 

 

Pieri F, Aldini NN, Fini M, Marchetti C, Corinaldesi G. Rehabilitation of the Atrophic 

Posterior Maxilla Using Short Implants or Sinus Augmentation with Simultaneous Standard-

Length Implant Placement: A 3-Year Randomized Clinical Trial. Clin Implant Dent Relat 

Res. 2012 Dec;14(6):924. 

 

Pierrisnard L, Renouard F, Renault P, Barquins M. Influence of implant length and bicortical 

anchorage on implant stress distribution. Clin Implant Dent Relat Res. 2003;5(4):254-62. 

 

Rabel A, Köhler SG, Schmidt-Westhausen AM. Clinical study of the primary stability of two 

dental implant systems with resonance frequency analysis. Clin Oral Investig. 2007 

Sep;11(3):257-65. 

 

Reeves TE, Mah P, McDavid WD. Deriving Hounsfield units using grey levels in cone beam 

CT: a clinical application. Dentomaxillofac Radiol. 2012 Sep;41(6):500-8. 

Renouard F, Nisand D. Impact of implant length and diameter on survival rates. Clin Oral 

Implants Res. 2006 Oct;17 Suppl 2:35-51. 

 

Ribeiro-Rotta RF, Lindh C, Pereira AC, Rohlin M. Ambiguity in bone tissue characteristics as 

presented in studies on dental implant planning and placement: a systematic review. Clin Oral 

Implants Res. 2011 Aug;22(8):789-801. 

 

Ribeiro-Rotta RF, Lindh C, Rohlin M. Efficacy of clinical methods to assess jawbone tissue 

prior to and during endosseous dental implant placement: a systematic literature review. Int J 

Oral Maxillofac Implants. 2007 Mar-Apr;22(2):289-300. 



89 

 

Rodrigo D, Aracil L, Martin C, Sanz M. Diagnosis of implant stability and its impact on 

implant survival: a prospective case series study. Clin Oral Implants Res. 2010 

Mar;21(3):255-61. 

 

Rosenquist B. Fixture placement posterior to the mental foramen with transpositioning of the 

inferior alveolar nerve. Int J Oral Maxillofac Implants. 1992 Spring;7(1):45-50. 

 

Rossi F, Ricci E, Marchetti C, Lang NP, Botticelli D. Early loading of single crowns 

supported by 6-mm-long implants with a moderately rough surface: a prospective 2-year 

follow-up cohort study. Clin Oral Implants Res. 2010 Sep;21(9):937-43. 

 

Rozé J, Babu S, Saffarzadeh A, Gayet-Delacroix M, Hoornaert A, Layrolle P. Correlating 

implant stability to bone structure. Clin Oral Implants Res. 2009 Oct;20(10):1140-5. 

 

Scarfe WC, Farman AG, Sukovic P. Clinical applications of cone-beam computed 

tomography in dental practice. J Can Dent Assoc. 2006 Feb;72(1):75-80. 

 

Schulte W, Lukas D. Periotest tomonitor osseointegration and to check the occlusion in oral 

implantology. J Oral Implantol. 1993;19(1):23-32. 

 

Sennerby, L; Meredith, N. Implant stability measurements using resonance frequency 

analysis: biological and biomechanical aspects and clinical implications. Periodontol 2000. 

2008;47:51-66. 

 

Sim CP, Lang NP. Factors influencing resonance frequency analysis assessed by 

Osstelltmentor during implant tissue integration: I. Instrument positioning, bone structure, 

implant length. Clin Oral Implants Res. 2010 Jun;21(6):598-604. 

 

Song YD, Jun SH, Kwon JJ. Correlation between bone quality evaluated by cone-beam 

computerized tomography and implant primary stability. Int J Oral Maxillofac Implants. 2009 

Jan-Feb;24(1):59-64. 

 

Strietzel FP, Reichart RA. Oral rehabilitation using camlogs screw–cylinder implants with a 

particle-blasted and acid-etched microstructured surface: results from a prospective study with 

special consideration of short implants. Clin Oral Implants Res. 2007 Oct;18(5):591-600. 

 

Summers RB. The osteotome technique: part 4: future site development. Compend Contin 

Educ Dent. 1995 Nov;16(11):1090, 1092 passim; 1094-1096, 1098, quiz 1099. 

 

Tawil G, Younan, R. Clinical evaluation of short, machined-surface implants followed for 12 

to 92 months. Int J Oral Maxillofac Implants. 2003 Nov-Dec;18(6):894-901. 

 

Trisi P, Perfetti G, Baldoni E, Berardi D, Colagiovanni M, Scogna G. Implant micromotion is 

related to peak insertion torque and bone density. Clin Oral Implants Res. 2009 

May;20(5):467-71. 

 

Trisi P, Rao W. Bone classification: clinicalhistomorphometric comparison. Clin Oral 

Implants Res. 1999 Feb;10(1):1-7. 

 

 



90 

 

 

Turkyilmaz I, Tözüm TF, Tumer C. Bone density assessments of oral implant sites using 

computerized tomography. J Oral Rehabil. 2007 Apr;34(4):267-72. 

 

Turkyilmaz I, Aksoy U, McGlumphy EA. Two Alternative Surgical Techniques for 

Enhancing Primary Implant Stability in the Posterior Maxilla: A Clinical Study Including 

Bone Density, Insertion Torque, and Resonance Frequency Analysis Data. Clin Implant Dent 

Relat Res. 2008 Dec;10(4):231-7. (a). 

 

Turkyilmaz I, Ozan O, Yilmaz B, Ersoy AE. Determination of bone quality of 372 implant 

recipient sites using Hounsfield unit from computerized tomography: a clinical study. Clin 

Implant Dent Relat Res. 2008 Dec;10(4):238-44 (b). 

 

Valiyaparambil JV, Yamany I, Ortiz D, Shafer DM, Pendrys D, Freilich M, et al. Bone 

quality evaluation: comparison of cone beam computed tomography and subjective surgical 

assessment. Int J Oral Maxillofac Implants. 2012 Sep-Oct;27(5):1271-7. 

 

Van Steenberghe D, Lekholm U, Bolender C, Folmer T, Henry P, Herrmann I, et al. The 

applicability of osseointegrated oral implants in the rehabilitation of partial edentulism: a 

prospective multicenter study on 558 fixtures. Int J Oral Maxillofac Implants. 1990 

Fall;5(3):272-81. 

 

Walker LR, Morris GA, Novotny PJ. Implant insertional torque values predict outcomes. J 

Oral Maxillofac Surg. 2011 May;69(5):1344-9. 

 

White SC, Pharoah, MJ. Oral radiology: principles and interpretation. 5th ed. Philadelphia: 

Mosby; 2004.  

 

Zix J, Hug S, Kessler-Liechti G, Mericske-Stern R. Measurement of dental implant stability 

by resonance frequency analysis and damping capacity assessment: comparison of both 

techniques in a clinical trial. Int J Oral Maxillofac Implants. 2008 May-Jun;23(3):525-30. 

 

Zix J, Kessler-Liechti G, Mericske-Stern R. Stability measurements of 1-stage implants in the 

maxilla by means of resonance frequency analysis: A pilot study. Int J Oral Maxillofac 

Implants. 2005 Sep-Oct;20(5):747-52. 

 



91 

 

ANEXO A –  CARTAS DE APROVAÇÕES EM COMITÊ DE ÉTICA EM PESQUISA 

 

 



92 

 

 



93 

 

 



94 

 

ANEXO B – TERMO DE ONSENTIMENTO LIVRE E INFORMADO 

 
Influência do Bruxismo e da Força de Mordida no Prognóstico de Implantes Curtos 

Unitários em Região Posterior 

Influence of bruxism and biting force on the prognosis of single short implants in the 

posterior region  

 
 

CONSENTIMENTO LIVRE E ESCLARECIDO 

 

Faculdade de Odontologia da PUCRS 

 
 

 Eu,___________________________________________, fui solicitado a participar de um 

estudo denominado “Influência do Bruxismo e da Força de Mordida no Prognóstico de 

Implantes Curtos Unitários em Região Posterior” cujos objetivos são avaliar índice de sucesso 

e longevidade de implantes curtos unitários instalados na região posterior da maxila e da 

mandíbula, e avaliação da perda óssea periimplantar aos 6 e 12 meses em função da força de 

mordida e da presença ou não de bruxismo. 

 

A minha participação no referido estudo será de receber um implante dentário, 

utilizando o protocolo de um estágio cirúrgico, na região posterior de maxila e mandíbula. 

Após o tempo de cicatrização de 45 dias, será confeccionada uma coroa unitária metálo-

cerâmica. Serão feitas tomografias computadorizadas e radiografias periapicais para a 

avaliação da perda óssea marginal. Fui alertado de que, da pesquisa a se realizar, posso 

esperar alguns benefícios, tais como: restauração do dente ausente, possibilidade de 

tratamento sem necessidade de cirurgias de enxertos ósseos e/ou desgastes adicionais nos 

dentes adjacentes para confecção de uma prótese convencional fixa ou removível. 

 

 Recebi, por outro lado, os esclarecimentos necessários sobre os possíveis desconfortos e 

riscos decorrentes do estudo, tais como: falha na osseointegração, dor, edema e infecção 

(riscos de qualquer cirurgia de implante), e perda tardia do implante. A minha participação é 

voluntária, e possuo o direito de desistir do estudo em qualquer momento. Compreendo 

também que as informações coletadas são confidenciais e que não serão divulgadas sem o 

meu consentimento escrito. Somente a descrição referente ao grupo de participantes é que se 

encontra a disposição do pesquisador, não podendo este identificar os participantes 

envolvidos em nenhum dos seus resultados. 

 

O Dr. Diego Triches discutiu comigo o estudo e todas as minhas perguntas foram 

respondidas. Caso alguma outra exista, eu estou autorizado a contactá-lo para qualquer 

esclarecimento no telefone (51) 3022-8669 em horário comercial, ou a Profa. Rosemary 

Shinkai no telefone (51) 3220-3538, durante o horário comercial.  Para qualquer pergunta 

sobre os meus direitos como participante deste estudo ou se penso que fui prejudicado pela 

minha participação, posso entrar em contato com o Comitê de Ética em Pesquisa da PUCRS 

pelo telefone (51) 3320-3345. 

Fui informado de que terei que pagar os custos do implante, componentes protéticos, 

laboratório de prótese e a tomografia computadorizada inicial para diagnóstico e 

planejamento. 
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Fui informado, ainda, que caso existam danos à minha saúde, causados diretamente 

pela pesquisa, terei direito a tratamento odontológico e indenização conforme estabelece a lei. 

Também sei que caso existam gastos adicionais, estes serão absorvidos pelo orçamento da 

pesquisa. 

 

Declaro que recebi cópia do presente Termo de Consentimento. Minha assinatura 

indica que decidi participar desta pesquisa e entendi as informações dadas acima e explicadas 

a mim. Recebi informação a respeito do tratamento recebido e esclareci minhas dúvidas. Sei 

que em qualquer momento poderei solicitar novas informações e modificar minha decisão se 

assim eu o desejar, que todos os dados desta pesquisa serão confidenciais, bem como o meu 

tratamento não será modificado em razão desta pesquisa e terei liberdade de retirar meu 

consentimento de participação na pesquisa.  

 

Nome do Paciente: ______________________________________ Data: ____/____/____ 

Assinatura do Paciente: ____________________________________________________ 

 

Nome do Pesquisador: ___________________________________ Data: ____/____/____ 

Assinatura do Pesquisador: _________________________________________________ 

 

Este formulário foi lido para -_________________________________________________ 

(nome do paciente) em ____/____/____ (data) pelo ______________________________ 

(nome do pesquisador) enquanto eu estava presente. 

 

Nome da Testemunha: ___________________________________ Data: ____/____/____ 

Assinatura de testemunha: __________________________________________________ 
 

 


